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Preface

• Preface, page vii

Preface
Cisco Prime License Manager provides simplified, enterprise-wide management of user-based licensing,
including license fulfillment. Cisco Prime License Manager handles licensing fulfillment, supports allocation
and reconciliation of licenses across supported products, and provides enterprise-level reporting of usage and
entitlement.

You have the ability to define how to manage licensing of your enterprise. You can have one Cisco Prime
License Manager for the entire enterprise, or you can have several Cisco Prime License Managers and
divide the enterprise in a manner that best suits your needs.

Note

Cisco Prime License Manager runs on a virtual machine or may co-reside on a product's virtual machine if
that product supports co-resident deployment.

Purpose

The Cisco Prime License Manager User Guide provides instructions on how to install, set up, and use Cisco
Prime License Manager.

Audience

This document provides information for network administrators and engineers who are responsible for installing
and managing Cisco Prime License Manager.

Obtaining Technical Assistance

Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can obtain
documentation, troubleshooting tips, and sample configurations from online tools. For Cisco.com registered
users, additional troubleshooting tools are available from the Cisco Technical Assistance Center website.
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Related Documentation

For information on the products that Cisco Prime License Manager supports, refer to the product-specific
licensing documentation.
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C H A P T E R  1
Deployment

• Deployment Options, page 1

• Supported Products, page 1

• Supported Locales, page 2

• Supported Browsers, page 3

Deployment Options
You can deploy Cisco Prime License Manager in one of the following ways:

• Coresident deployments—Cisco Prime License Manager is installed automatically as part of the
installation of Cisco Unified Communications Manager and Cisco Unity Connection. You may choose
to run Cisco Prime License Manager on one of these servers in a coresident configuration. Refer to the
latest release of the platform-specific installation document for more information:

◦Installing Cisco Unified Communications Manager

◦Installation Guide for Cisco Unity Connection

◦Installing Cisco Business Edition 6000

• Standalone deployments—Cisco Prime LicenseManager ISO is available either from the DVD that was
sent to you or is available at the Software Download Center under Cisco Prime License Manager Virtual
Machine Templates.

Supported Products
Cisco Prime License Manager supports the following products:
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Cisco Prime License Manager Release
10.x

Enterprise License Manager Release
9.1

Product

YesYesCisco Unified
Communications
Manager Release 9.1

YesYesCisco Unity Connection
Release 9.1

YesYes, with license definition updates
(see License Definitions, on page 48)

Cisco Unified
Communications
Manager Release 10.x

YesYes, with license definition updates
(see License Definitions, on page 48)

Cisco Unity Connection
Release 10.x

YesNoCisco Emergency
Responder Release 10.x

Supported Locales
The following locales are supported for Cisco Prime License Manager:

• English (default)

• Japanese

• Chinese (simplified)

• Korean

• Chinese (traditional)

• German

• French (France)

• Italian

• Spanish (Spain)

• Spanish (Latin American) - also known as Spanish (Colombia)

• Portuguese (Brazil)

• Dutch (Netherlands)

• Russian
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Supported Browsers
The following table defines Cisco Prime License Manager browser support:

Apple OSWindows OSBrowser VersionBrowser

OSX 10.8Win 7 (32 and 64 bit)Win 8

SupportedSupportedSupportedFF 17-33Firefox

SupportedSupportedSupportedChrome 23-24Chrome

SupportedSupportedSupportedChrome 22

SupportedNot supportedNot supportedSafari 6.0-6.1Safari

N/ASupportedSupportedIE 9-10Internet Explorer

N/ASecondaryNot supportedIE 8

The following browsers and operating systems are not currently supported: Opera, Linux OS, Google
Chrome OS.

Note
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C H A P T E R  2
Installation and Upgrade

• Before You Begin, page 5

• Perform Pre-Installation Tasks for Cisco Prime License Manager, page 6

• Frequently Asked Questions About the Installation, page 6

• Cisco Prime License Manager Port Usage, page 7

• Gather Information for Installation, page 8

• Install Cisco Prime License Manager, page 12

• Upgrade Software using the Cisco Prime License Manager GUI, page 14

• Upgrade from a Remote File System, page 14

• Upgrade from a Local Source, page 15

• Upgrade Software using the Cisco Prime License Manager CLI, page 16

• Install COP Files, page 21

Before You Begin
This section describes how to install Cisco Prime License Manager on a virtual machine. You install the
operating system and application by running one installation program.

System requirements for installation

As defined in the OVA that should be used to install Cisco Prime License Manager, the following are the
server requirements:

Table 1: Cisco Prime License Manager Installation Server Requirements

DetailsRequirement

Cisco Prime License ManagerProduct

10.0(1)Version

1 vCPU with 1800 Mhz reservationCPU
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DetailsRequirement

4 GB (RAM) with 4 GB reservationMemory

1 - 50 GB diskHard Drive

The Cisco Prime License Manager OVA image is available for download at the Software Download Center,
http://software.cisco.com, under Downloads Home > Products > Cloud and Systems Management >
Collaboration and Unified Communications Management > Cisco Prime License Manager > Cisco
Prime License Manager 10.0.

Perform Pre-Installation Tasks for Cisco Prime License Manager
Perform all pre-installation tasks to ensure that you can successfully install Cisco Prime License Manager.

Procedure

Step 1 Review the installation requirements and record the configurations settings for the server that you plan to
install.

Step 2 Create your virtual machine using the Cisco Prime License Manager Virtual Server Template (OVA file)
recommended for your current release.

Step 3 Verify that you have an NTP server accessible, since an NTP server is required for VMware deployments.
Step 4 Ensure that the network interface card (NIC) speed and duplex settings on the switch port are the same as

those that you plan to set on the new server.
For GigE (1000/FULL), you should set NIC and switch port settings to Auto/Auto. Do not set hard values.

Step 5 Enable PortFast on all switch ports that are connected to Cisco servers.
With Portfast enabled, the switch immediately brings a port from the blocking state into the forwarding state
by eliminating the forwarding delay (the amount of time that a port waits before changing from its
Spanning-Tree Protocol (STP) learning and listening states to the forwarding state).

Step 6 Ensure that the hostname and address you play to use for Cisco Prime License Manager are registered with
the name server and that both forward and reverse lookups where possible.

Frequently Asked Questions About the Installation
The following section contains commonly asked questions and responses. Review this section carefully before
you begin the installation.

How Much Time Does the Installation Require?

The entire Cisco Prime License Manager installation process, excluding pre- and post-installation tasks, takes
approximately 30 minutes.
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What Usernames and Passwords Do I Need to Specify?

During the installation, you must specify the following usernames and passwords:

• OS Administrator account username and password

• Security password

• Cisco Prime License Manager application account username and password

Use the OS Administrator account username and password to log into the Command Line Interface. Use the
Cisco Prime LicenseManager application account username and password to log into the Cisco Prime License
Manager GUI interface.

You can change the Administrator account password or add a new Administrator account by using the
command line interface. For more information, see the “Command line interface for Cisco Prime License
Manager" section.

Note

What is a Strong Password?

The installation wizard checks to ensure that usernames and passwords configured during installation follow
these guidelines:

• Username—A usernamemust start with an alphabetic character and can contain alphanumeric characters,
hyphens, and underscores.

• Password—A password must be at least six characters long and can contain alphanumeric characters,
hyphens, and underscores.

In addition to the above requirements, we recommend that you create a strong password:

• Mix uppercase and lowercase letters.

• Mix letters and numbers.

• Include hyphens and underscores.

• Remember that longer passwords are stronger and more secure than shorter ones.

Can I Install Other Software on the Virtual Machine?

You cannot install or use unapproved third-party software applications. The system can upload and process
only software that is Cisco approved.

Approved software installations and upgrades can be performed using the CLI.

Cisco Prime License Manager Port Usage
The following table provides a list of ports that you should allow through your firewall for Cisco Prime License
Manager.
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Outbound PortInbound PortProtocolDescription

N/A80/8080, 443/8443TCPBrowser HTTP

N/A22TCPSSH/SFTP

N/A32768-61000TCP, UDPEphemeral port ranges for
clients initiating
connections

53N/ATCP, UDPDNS name resolution

80, 8080, 443, 8443
(HTTP and HTTPS)

N/ATCPTo connect to Product
instances and to Cisco
Back office for
e-Fulfillment

22 (SSH/SFTP)N/ATCPDRS

67N/AUDPDHCP client

123N/ATCP, UDPNTP client

Gather Information for Installation
Use the following table to collect information that is pertinent to your system and network configuration.

Table 2: Server Configuration Data

Can Entry Be Changed After
Installation?

DescriptionParameter

No, you cannot change the entry after
installation.

After installation, you can
create additional
Administrator accounts, but
you cannot change the
original Administrator
account username.

Note

This field specifies the OS
Administrator account username that
you use for secure shell access to the
CLI on Cisco Prime License
Manager.

OS Administrator Account
Username
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Can Entry Be Changed After
Installation?

DescriptionParameter

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set password user admin

This field specifies the password for
the Administrator account, which
you use for secure shell access to the
CLI.

You also use this password with the
adminsftp user. You use the
adminsftp user to access local
backup files, upload server licenses,
and so on.

For guidelines relating to strong
passwords, see the corresponding
password section.

OS Administrator Password

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > license management change
user name

This field specifies the Cisco Prime
LicenseManager application account
username that you use to log on to
Cisco Prime License Manager GUI.

Cisco Prime License
Manager Application
Account Username

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > license management change
user password

This field specifies the password for
the Cisco Prime License Manager
application account, which you use
for secure shell access to Cisco
Prime License Manager GUI.

Cisco Prime License
Manager Application
Password

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set web-security

From the list, choose the appropriate
organization, unit, location, and state
for your installation.

Certificate Parameters

No, you should not change the entry
after installation.

Cisco Prime License Manager
requires a static IP address. As a
result, we recommend that you
chooseNo for the DHCP option and
then enter a hostname, IP address,
IP mask, and gateway.

DHCP

No, you should not change the entry
after installation.

A DNS server resolves a hostname
into an IP address or an IP address
into a hostname.

Choose Yes to enable DNS. This
will ensure that e-fulfillment will
work properly.

DNS Enable
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Can Entry Be Changed After
Installation?

DescriptionParameter

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set network dns

To view DNS and network
information, use the following CLI
command:

CLI > show network eth0 detail

Enter the IP address of the DNS
server that you want to specify as the
primary DNS server. Enter the IP
address in dotted decimal format as
ddd.ddd.ddd.ddd.

DNS Primary

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set network dns

Enter the IP address of the DNS
server that you want to specify as the
optional secondary DNS server.

DNS Secondary (optional)

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set network gateway

Enter the IP address of the network
gateway.

If you do not have a gateway, you
must still set this field to
255.255.255.255. Not having a
gateway will prevent Cisco Prime
License Manager from
communication outside of its subnet
and will prevent the use of
e-fulfillment.

Gateway Address

Yes, you can change the entry after
installation.

CLI > set network hostname

Do not change your
hostname while any tasks
are running.

Note

Enter a hostname that is unique to
your server.

The hostname can comprise up to 32
characters and can contain
alphanumeric characters and
hyphens. The first character cannot
be a hyphen.

Hostname

Yes, you can change the entry after
installation.

CLI > set network ip eth0

Enter the IP address of your server.n

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set network ip eth0

Enter the IP subnet mask of this
machine.

IP Mask
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Can Entry Be Changed After
Installation?

DescriptionParameter

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set web-security

Enter the location of the server.

You can enter any location that is
meaningful within your organization.
Examples include the state or the city
where the server is located.

Location

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set network mtu

The maximum transmission unit
(MTU) represents the largest packet,
in bytes, that this host will transmit
on the network.

Enter theMTU size in bytes for your
network. If you are unsure of the
MTU setting for your network, use
the default value.

Default specifies 1500 bytes.

MTU Size

Yes, you can change the entry after
installation Yes, you can change the
entry after installation

CLI > utils ntp server

Enter the hostname or IP address of
one or more Network Time Protocol
(NTP) servers with which you want
to synchronize.

You can enter up to five NTP
servers.

To avoid potential
compatibility, accuracy, and
network jitter problems, the
external NTP servers that
you specify for the primary
node can be NTP v4
(version 4). If you are using
IPv6 addressing, external
NTP servers must be NTP
v4.

Note

NTP Server

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set web-security

Enter the name of your organization.

You can use this field to
enter multiple organizational
units. To enter more than one
organizational unit name,
separate the entries with a
comma. For entries that
already contain a comma,
enter a backslash before the
comma that is included as
part of the entry.

Tip

Organization
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Can Entry Be Changed After
Installation?

DescriptionParameter

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set password user security

Enter your security password.

The password must contain at least
six alphanumeric characters. The
password can contain hyphens and
underscores, but it must start with an
alphanumeric character.

Security Password

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set web-security

Enter the state that the server is
located.

State

Yes, you can change the entry after
installation by using the following
CLI command:

CLI > set timezone

To view the current time zone
configuration, use the following CLI
command:

CLI > show timezone config

This field specifies the local time
zone and offset from Greenwich
Mean Time (GMT).

Choose the time zone that most
closely matches the location of your
machine.

Time Zone

Install Cisco Prime License Manager

Install Virtual Machine
Use this procedure and your VMware documentation to install your virtual machine.

Procedure

Step 1 From the vCenter Client, open the console of your newly installed virtual machine.
Step 2 From the vCenter Client, choose File > Deploy OVF Template.
Step 3 Follow the deploy OVF template wizard to create the Cisco Prime License Manager virtual machine

After the installation is complete, the newly installed virtual machine appears in the selected location within
the vCenter Client.
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Install Cisco Prime License Manager

Before You Begin

Install virtual machine.

Procedure

Step 1 Using the vCenter Client, choose Edit virtual machine settings > Network adapter 1 > MAC Address .
Step 2 Select the Manual option and enter a unique MAC address.

For a standalone installation of Cisco Prime License Manager, only static MAC addresses are supported on
the virtual machine.

Step 3 From the vCenter Client, open the console of your virtual machine.
Step 4 Power on the virtual machine. The installation begins automatically.
Step 5 If you are using an ISO file, click Skip on the Disc Found screen to skip testing the media before installation.

Otherwise, choose the OK tab and press Enter to initiate testing of the media before installation.
The Media Found screen appears with the following message: "Found local installation media."

Step 6 The Product Deployment Selection screen appears. Select the product (there may only be one product available
to select) and click OK to proceed with the installation.

Step 7 Click Yes.
Step 8 The Platform Installation Wizard screen appears. Choose Proceed to continue with the installation.
Step 9 The Basic Install screen appears. Click Continue.
Step 10 In the Timezone Configuration screen, select your timezone and click OK.
Step 11 Click Continue at the Auto Negotiation Configuration screen.
Step 12 When asked if you want to change the MTU size from the OS default, click No to proceed.
Step 13 For network configuration, choose No to set up a static network IP address for the node .

The Static Network Configuration screen appears.
Step 14 Enter the following static network configuration values and choose .

• Host Name

• IP Address

• IP Mask

• GW Address

Click OK. Go to Step 14.

Step 15 The DNS Client Configuration screen appears. To enable DNS, click Yes, then enter your DNS client
information and click OK.

Step 16 Enter your Administrator login and password information.
The Administrator login must start with an alphabetic character, be at least six characters long, and
can contain alphanumeric characters, hyphens, and underscores. You will need the Administrator
login to log into the command line interface.

Note

Step 17 The Certificate Information window displays. Enter the Certificate Information:
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• Organization

• Unit

• Location

• State

• Country

Click OK to proceed.
Step 18 The Network Time Protocol Client Configuration screen appears. Enter your NTP server information.

If you are using Static, use an IP address. If using DHCP or DNS use an IP address or hostname.Note

Click OK to proceed.
Step 19 When asked, enter your Security Password. Click OK to continue.
Step 20 The Application User Configuration screen appears. Enter your username and password and log into Cisco

Prime License Manager. Click OK.
Step 21 The Platform Configuration Confirmation screen appears. Click OK to complete the configuration and start

the installation.
The installation will take approximately 30 minutes to complete.

If there is an installation failure, the console will direct you to export the installation logs to a USB
key, if required.

Note

Upgrade Software using the Cisco Prime License Manager GUI
You can use one of the following options to upgrade software using the Cisco Prime License Manager GUI:

• Upgrade from a remote file system

• Upgrade from a local source

Upgrade from a Remote File System
To upgrade the software from an FTP or SFTP server, use the following procedure. Keep in mind that this
procedure uses example software versions. For the latest software version, see the appropriate Release Notes
for Cisco Prime License Manager.

Before You Begin

Copy the application ISO file to an FTP server that is accessible from Cisco Prime License Manager.

Procedure

Step 1 From the Cisco Prime License Manager main menu, select Administration > Install/Upgrade.
The Install/Upgrade page opens.

Step 2 Click the Install/Upgrade Software button.
The Install/Upgrade Software dialog box opens.
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Step 3 Click the Install/Upgrade from Network radio button (this option should be selected by default).
Enter following information:

• IP Address/Hostname

• Username

• Password

• Directory (the path to the location where you placed the ISO)

• Transfer Protocol (choose either FTP or SFTP from the drop-down menu)

Step 4 Click Next.
Step 5 All valid upgrades are listed in the table. Select the required upgrade file from the list.

There can be multiple options
listed.

Note

Step 6 Click the Start Installation/Upgrade button. A message appears asking you to confirm the upgrade. Click
Continue to begin the upgrade.

You can leave the screen up while the upgrade is in progress, as it provides feedback on the progress
of the upgrade, or close the browser. The upgrade proceeds even if you close the browser. The upgrade
may take 45 minutes to an hour to complete.

Note

Upgrade from a Local Source
Before You Begin

Define the media source of the virtual machine. For example, is it an ISO file in the datastore or a physical
optical drive on the client or host. Check the Connected checkbox for the VM CD/DVD drive.

Procedure

Step 1 From the Cisco Prime License Manager main menu, choose Administration > Install/Upgrade.
The Install/Upgrade page opens.

Step 2 Click Install/Upgrade Software.
The Install/Upgrade Software dialog box opens.

Step 3 Click Install/Upgrade from DVD/CD drive on Cisco Prime License Manager server.
Step 4 All valid upgrades are listed in the table. Select the appropriate (valid) upgrade file from the list.
Step 5 Click Start Installation/Upgrade.

A message appears asking you to confirm the upgrade.
Step 6 Click Continue to begin the upgrade.

You can either leave the screen up while the upgrade is in progress or close your browser. Closing
your browser does not impact the upgrade process. The upgrade may take 45 minutes to an hour to
complete.

Note
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Upgrade Software using the Cisco Prime License Manager CLI
To initiate an upgrade from a local or remote source using CLI commands, use the following procedures.

Upgrade From Remote Source
To upgrade the software from an FTP server, use the following procedure. Keep in mind that this procedure
uses example software versions. For the latest software version, see the appropriate Release Notes for Cisco
Prime License Manager.

Before You Begin

You need to place the ISO on a network location or remote drive that is accessible from Cisco Prime License
Manager prior to starting this procedure.

Procedure

Step 1 Enter the utils system upgrade initiate command, as shown in the following example.

Example:
utils system upgrade initiate
The following options appear:

•Warning: Do not close this window without first canceling the upgrade.

• 1) Remote Filesystem via SFTP

• 2) Remote Filesystem via FTP

• 3) Local DVD/CD

• q) quit

• Please select an option (1 - 3 or "q" ):

Step 2 Select either option 1 or 2.
Step 3 Enter Directory, Server, User Name, and Password information when prompted.

• Please select an option (1 - 3 or "q" ): 1

• Directory: /software/PLM/10.0.0.98030-1

• Server: ftp.mycompany.com

• User Name: bsmith

• Password: ********

• Checking for valid upgrades. Please wait...

Step 4 Enter SMTP Host Server (optional) to receive email notification once upgrade is complete.
The following options appear:
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• Available options and upgrades in "se032c-94-61:/software/PLM/10.0.0.98030-1":

• 1) CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso

• q) quit

Step 5 Select option 1 to download upgrade file.
The following messages appear:

• Accessing the file. Please wait...

• Validating the file...

• Downloaded 935 MB.

• Checksumming the file...

• A system reboot is required when the upgrade process completes or is canceled. This will ensure services
affected by the upgrade process are functioning properly.

• Downloaded: CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso

• File version: 10.0.0.98030-1

• File checksum: c4:13:ad:95:7b:c8:c1:01:1b:91:bb:da:8d:84:09:ea

Step 6 When asked to automatically switch versions if the upgrade is successful, enter yes or no.
Automatically switch versions if the upgrade is successful (yes/no): yes

Step 7 Enter Yes to start installation.
Start installation (yes/no): yes

Upgrade From Local Source
To upgrade the software from an FTP server, use the following procedure. Keep in mind that this procedure
uses example software versions. For the latest software version, see the appropriate Release Notes for Cisco
Prime License Manager.

Before You Begin

Define the media source of the virtual machine. For example, is it an ISO file in the datastore or a physical
optical drive on the client or host. Check the Connected checkbox for the VM CD/DVD drive.

Procedure

Step 1 Insert the new DVD into the disc drive on the local server that is to be upgraded.
Step 2 Enter the utils system upgrade initiate command, as shown in the following example.

Example:
admin:utils system upgrade initiate
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The following options appear:
Warning: Do not close this window without first exiting the upgrade command.
Source: 1) Remote Filesystem via SFTP 2) Remote Filesystem via FTP 3) Local DVD/CD
q) quit Please select an option (1 - 3 or "q" ):

Step 3 Select option 3.
1) CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso q) quit

Step 4 Select option 1 to download upgrade file.
Accessing the file. Please wait... Checksumming the file... Validating the file... A system reboot is required
when the upgrade process completes or is canceled. This will ensure services affected by the upgrade process
are functioning properly. Downloaded: CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso File version:
10.0.0.98030-1 File checksum: c4:13:ad:95:7b:c8:c1:01:1b:91:bb:da:8d:84:09:ea

Step 5 When asked to automatically switch versions if the upgrade is successful, enter yes or no.
Automatically switch versions if the upgrade is successful (yes/no): yes

Step 6 Enter yes to start installation.
Start installation (yes/no): yes

Post-Upgrade Tasks
After the upgrade, perform the following tasks:

• Check the version number in the About box to verify that it is the expected upgraded version.

• Perform a synchronization by selecting Product Instances > Synchronize Now.

• Check the Dashboard to verify that there are no alerts.

Change Hostname using the Cisco Prime License Manager CLI
This procedure describes how to use the CLI to change the IP address or hostname for the Cisco Prime License
Manager.

Do not change both the IP address and the hostname at the same time.Note

Before You Begin

If you have DNS configured anywhere on Cisco Prime LicenseManager, ensure that the following conditions
exist before you change the IP address:

• The forward and reverse records (for example, A record and PTR record) for the new IP address and
host name.

• The DNS is reachable and working.
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Procedure

Step 1 To check network connectivity and DNS server configuration, enter the utils diagnose CLI command as
shown in the following example:

admin: utils diagnose module validate_network
Log file: /var/log/active/platform/log/diag1.log

Starting diagnostic test(s)
===========================
test - validate_network : Passed

Diagnostics Completed
admin:

Step 2 Run a manual backup and ensure that all active services are backed up successfully.
Step 3 Enter the set network hostname CLI command and follow the prompts to change the hostname, IP address,

or default gateway. See the following example:

admin:set network hostname

WARNING: To avoid license synchronization failures, delete the
product instance from the Cisco Prime License Manager
managing this server's licenses before changing network
settings. You will have to re-add the product instance
after the network settings have been changed.

Continue (y/n)?y

ctrl-c: To quit the input.

*** W A R N I N G ***
Do not close this window without first canceling the command.

This command will automatically restart system services.
The command should not be issued during normal operating
hours.

=======================================================
Note: Please verify that the new hostname is a unique

name across the cluster and, if DNS services are
utilized, any DNS configuration is completed
before proceeding.

=======================================================

Security Warning : This operation will regenerate
all CUCM Certificates including any third party
signed Certificates that have been uploaded.

Enter the hostname:: newHostname
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Would you like to change the network ip address at this time [yes]::

Warning: Do not close this window until command finishes.

ctrl-c: To quit the input.

*** W A R N I N G ***
=======================================================
Note: Please verify that the new ip address is unique

across the cluster.
=======================================================

Enter the ip address:: 10.10.10.28
Enter the ip subnet mask:: 255.255.255.0
Enter the ip address of the gateway:: 10.10.10.1
Hostname: newHostname
IP Address: 10.10.10.28
IP Subnet Mask: 255.255.255.0
Gateway: 10.10.10.1

Do you want to continue [yes/no]? yes

calling 1 of 5 component notification script: ahostname_callback.sh
Info(0): Processnode query returned =
name
==========
bldr-vcm18
updating server table from:'oldHostname', to: 'newHostname'
Rows: 1
updating database, please wait 90 seconds
updating database, please wait 60 seconds
updating database, please wait 30 seconds
Going to trigger /usr/local/cm/bin/dbl updatefiles
--remote=newHostname,oldHostname
calling 2 of 5 component notification script: clm_notify_hostname.sh
notification
Verifying update across cluster nodes...
platformConfig.xml is up-to-date: bldr-vcm21

cluster update successfull
calling 3 of 5 component notification script: drf_notify_hostname_change.py

calling 4 of 5 component notification script: regenerate_all_certs.sh
calling 5 of 5 component notification script: update_idsenv.sh
calling 1 of 2 component notification script: ahostname_callback.sh
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Info(0): Processnode query returned =
name
====
Going to trigger /usr/local/cm/bin/dbl updatefiles
--remote=10.10.10.28,10.67.142.24
calling 2 of 2 component notification script: clm_notify_hostname.sh
Verifying update across cluster nodes...
Shutting down interface eth0:

Step 4 Complete the Post-Change Task List, on page 21.

Post-Change Task List
After you finish changing the IP addresses or hostname, complete the tasks in the following procedure.

Procedure

Step 1 Run a backup and ensure that all active services back up successfully. For more information, see the
Backup/Restore section of the Administration chapter.

You must run a manual DRS backup after you change the IP address of a node, because you cannot
restore a node with a DRS file that contains a different IP address or hostname. The post-change
DRS file will include the new IP address or hostname.

Note

Step 2 If using the integrated DHCP server that runs on Cisco Prime License Manager, update the DHCP server.
Step 3 Perform manual synchronization and verify that there are no alerts in the dashboard.

Install COP Files
Use the following procedure to install Cisco Option files (COP) files. COP files are used to enable additional
functionality (for example: patches).

Procedure

Step 1 Obtain the desired COP file from the Cisco Software Download Center on Cisco.com and store locally.
To access the Software Patches site, go to http://software.cisco.com , choose Upgrade and Update,
then selectDownload Software. From the Download Software page, navigate toDownloads Home
> Products > Cloud and Systems Management > Collaboration and Unified Communications
Management > Cisco Prime License Manager > Cisco Prime License Manager 10.0

Note

Step 2 Place the COP file on an FTP or SFTP server that the server that you are upgrading can access.
Step 3 Log in to Cisco Prime License Manager.
Step 4 Choose Administration > Install/Upgrade.

The Install/Upgrade page displays.

Step 5 Click Install/Upgrade Software.
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The Install/Upgrade Software window displays.
Step 6 In the Specify File Location section of the Install/Upgrade Software window, enter the following:

• IP Address/Hostname

• Username

• Password

• Directory

• Transfer Protocol

Step 7 Click Next.
The Select File section opens.

Step 8 All valid COP files are listed in the table. Select the appropriate (valid) COP file from the list and click Start
Installation/Upgrade to begin the install.
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C H A P T E R  3
Configuration

The following sections provide information about how to use Cisco Prime License Manager.

• Getting Started, page 23

• Log In, page 24

• Add Product Instance, page 24

• Edit Product Instance, page 25

• Delete Product Instance, page 26

• System Status Information, page 26

• Dashboard View, page 26

• License Usage View, page 27

• License Fulfillment View, page 30

• Migrate Licenses to Cisco Prime License Manager, page 32

• New License Planning and Fulfillment, page 42

• Upgrade Existing Licenses, page 44

• Other Fulfillment Options, page 45

Getting Started
Follow these steps to begin using Cisco Prime License Manager:

• Log in to Cisco Prime License Manager. See Log In, on page 24.

• Add a product instance. See Add Product Instance, on page 24.

• Use the Dashboard or the License Usage page to determine what licenses are required for your product.
For more information on the Dashboard or the License Usage pages, see System Status Information,
on page 26.
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• Migrate your existing licenses if your Cisco Prime License Manager is managing any product instances
that have been upgraded from a prior version of the product that implemented a different licensing
methodology.

See Migrate Licenses to Cisco Prime License Manager, on page 32.

• Perform new license fulfillment. See License Planning, on page 42.

Log In
To log into a standalone Cisco Prime License Manager, enter your username and password. Click Login.

For coresident configurations, use the following procedure to log in:

Procedure

Step 1 Select Cisco Prime License Manager from the list of installed applications.
Step 2 Enter your username and password. Click Login

The initial login requires the application username and password that you created as part of the
installation. If you are not sure what username and password to use for signing into Cisco Prime
License Manager, see Troubleshooting, on page 75.

Note

The “Getting Started” window appears with options for the following:

• Add Product Instance, on page 24

• New License Planning and Fulfillment, on page 42

The “Getting Started” window will not appear after you add an instance, or install a license. You can
also select the Do not show this again option to disable the window. If the window appears after
you have completed these steps, log out of the Cisco Prime LicenseManager session and log in again.

Note

Add Product Instance
The following procedure describes how to add a product instance in Cisco Prime License Manager.

Before You Begin

Install licenses that are installable at the product instance prior to adding the product instance. This will ensure
that those licenses are eligible for migration.

If you want to add a Cisco Unified Communications Manager instance, check the status of the account using
the following command: show accountlocking. The account locking setting must be set to disabled to avoid
a 401 error when you attempt to add the product instance.
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Procedure

Step 1 Log in to Cisco Prime License Manager.
Step 2 Choose Product Instances.
Step 3 Click Add. The Product Add dialog box appears.
Step 4 Enter the following information:

• Name

• Description (optional)

• Product Type

• Hostname/IP Address

• Username

• Password

Credentials are the OSAdministration username and password of the product.Note

Step 5 Click OK to add the product instance.
Step 6 Once the product instance has been successfully added, the product appears in the Product Instances table.

On the Product Instances page, click the Synchronize Now button to request the licensing information
from the new product. If you do not synchronize, current product instance information will not appear
in Cisco Prime License Manager.

Note

"Contains Migratable Licenses" appears in the Status field for all product instances whose licenses
have not yet beenmigrated to Cisco Prime LicenseManager. Tomake any licenses that are installable
at the product instance available in the Cisco Prime License Manager, they must be migrated. For
information on migrating licenses, see: Migrate Licenses to Cisco Prime License Manager, on page
32.

Note

Edit Product Instance
The following procedure describes how to edit a product instance in Cisco Prime License Manager.

Procedure

Step 1 To edit a product instance, select that instance from the Product Instances table.
Step 2 From the General tab of the Product Instance details page, edit the preferred settings for the product instance.

If the hostname or IP address of the product instance changes, you need to delete the product
instance from the Cisco Prime License Manager prior to changing the hostname/IP address. You
then re-add it to the Cisco Prime License Manager once you have completed the hostname/IP
address change.

Important
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Delete Product Instance
Procedure

Step 1 In the Action column for the product instance you wish to delete, click the Delete button.
Step 2 A message appears, confirming that the product instance was successfully deleted.
Step 3 Following a successful deletion, click the Synchronize Now button to obtain the most up-to-date licensing

information for all license types in the system.

System Status Information
The Cisco Prime License Manager interface provides the following views that enable you to monitor the
system status:

• Dashboard View, on page 26

• License Usage View, on page 27

Dashboard View
The Dashboard provides an “at-a-glance” view of the system. Links in the Dashboard navigate to their related
pages within Cisco Prime License Manager.

When Cisco Prime License Manager is first installed, it operates in Demo mode until a license file is
installed. While Cisco Prime License Manager is in Demo mode, a warning appears at the top of the GUI.

Note

Demo mode in Cisco Prime License Manager refers to the fact that no license file has been installed yet.
During the first license file installation process, Cisco Prime License Manager is registered with the Cisco
licensing back office and is no longer in Demo mode. Product instances managed by Cisco Prime License
Manager are not in compliance as long as Cisco Prime License Manager is in Demo mode. Each product
type (for example, Unified CM, Unity Connection) has its own version of "demo mode" that operates
independently of Cisco Prime License Manager’s Demo mode.

Note

The Dashboard contains the following:

Overview

Provides information on Product Instances, Last License Update, and Last Synchronization date and time.
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License Usage

Lists the product type and the number of licenses:

• Installed

• Required

License Alerts

Lists alerts according to product type, the status of the alert and the number of licenses available. Alerts
indicate:

• License types that are non-compliant

• Licenses that are nearing expiration

Product Instance Alerts

Lists the product instance name, status (including product grace period expiration), and last successful
synchronization.

The product grace period expiration provides additional information for products with insufficient licenses.
Clicking on the red "x" or alert symbol in the Status column provides more detailed information (for
example: "This product instance is consuming more licenses than are available in Cisco Prime License
Manager and may experience service degradation until you install sufficient licenses to cover its usage.
Check your product documentation for more information.").

Note

License Usage View
The License Usage view, accessed by selecting Licenses > Usage in the Cisco Prime License Manager
interface, identifies the licenses installed on the system and how those licenses have been used at the time of
the last synchronization.

There are three views available from the License Usage view:

• Table View

• Chart View

• History

Table View

The Table View provides the following information for each license type:

• Type of licenses in use

• Product Type

• Number of licenses required

• Number of licenses installed
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• Number of licenses available

• Status of that license type (for example: in compliance, in violation, and so on)

License versions are shown as “9.x” rather than “9.0”. This reduces confusion as 9.0 licenses are valid for
all 9.x licenses.

Note

You can also view license properties and usage by selecting one of license types installed on the system. The
License Type details page contains the following information:

• License Description

• Usage Chart

• Usage by Instance

• Installed Licenses by Type

For a comprehensive view of all license types, click the View All License Type Descriptions and Device
Classifications (new window) link under the License Description section.

Chart View

The Chart View tab presents a graphical view of the number of licenses used for a particular product.

Select theLicense Type from the drop-downmenu to view the chart for that license version. Place your mouse
over each of the chart's bars to reveal license count information. The figure below shows a Chart View,
customized for each product type, which illustrates the number of licenses:

• Installed

• Borrowed from Upper Tier

• Required

• Loaned to Lower Tier

The Chart View also identifies, with a red “x”, instances where there are insufficient licenses.

   Cisco Prime License Manager User Guide, Release 10.0(1)
28

Configuration
License Usage View



The chart you see depends largely on the license type you select from the drop-down menu. For example,
Unified CM and has borrowing and tiering whereas Emergency Responder does not. The legend is hidden
for product types that do not support license substitution.

Note

Figure 1: License Usage - Chart View

History

This History tab enables you to view how your license usage has changed over time. Usage data is collected
at every synchronization with product instance and with each action that changes license usage. To download
your usage history, select a date range and the product and click the Generate File button.

Clicking the Generate File button creates a History report that appears at the bottom of the History tab. You
can download the History report into a csv file that can be opened in a spreadsheet application. The History
report shows licensing installed and license consumption, including the compliance status.

Substitution and Tiering

Substitution and tiering does not apply to all products supported by Cisco Prime License Manager. If your
product supports substitution and tiering, refer to the following description and examples.

Note

License types are categorized into license tiers, where the higher license tiers offer more functionality than
the lower tiers. For example, CUWLProfessional, the highest Unified CM-tiered type, offers more functionality
than CUWL Premium or Advanced (the exact functionality is specified in the License Usage Details screen).
The License Usage Table View and Chart View (as shown in the figure above) display the types in order of
tier, highest to lowest.

License substitution refers to the Cisco Prime License Manager feature where a higher tier license type can
be substituted for a lower-tiered type that would otherwise be in overage. In the Chart View example (in the
above figure), there are 50 spare CUWL Professional licenses on loan to Basic. In this example, the 50 spare
licenses are sufficient to cover the entire Basic overage. If the user installs a license file that adds Basic licenses,
the spare CUWL Professional license would then be available for future CUWL Professional requirements.
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License Fulfillment View
Once a product instance has been added (see Add Product Instance, on page 24), you must then identify your
licensing requirements and plan accordingly.

You may wish to check your Dashboard or License Usage page first, to determine what licenses are
required for your product. For more information on the Dashboard or the License Usage pages, see System
Status Information, on page 26.

Note

If you have licenses that are installable at the product instance that require migration, seeMigrate Licenses
to Cisco Prime License Manager, on page 32.

Important

Cisco Prime License Manager provides two main options for performing license fulfillment:

• Electronic fulfillment (e-Fulfillment)

• Manual fulfillment

Under each of these fulfillment options, you may choose to do one of the following:

• New license fulfillment

• License upgrade

e-Fulfillment is the quicker and easier option of the two; however, in deployments where internet connectivity
is not available (a locked-down lab for example) Manual fulfillment may be the only option.

e-Fulfillment supports:

• License feature upgrades (for example, a Basic UCL to Enhanced UCL upgrade)

• License version upgrades (for example, a version 9.0 to version 10.0(1) license upgrade)

License Product Authorization Keys (PAKs) can be fulfilled and installed directly from the Cisco Prime
License Manager.

e-Fulfillment

Use the following procedure to add new licenses via e-Fulfillment.

1 Log in to Cisco Prime License Manager.

2 Select Licenses > Fulfillment.

3 If not already selected, click the Enable button to enable e-Fulfillment.

4 Select Fulfill Licenses from PAK. The Fulfill Licenses from PAK window appears.

5 Select the Add licenses from a new PAK option and enter the Product Authorization Key (PAK) code.

If you have previously entered PAKs in Cisco Prime License Manager, you may select the second option,
"Add licenses from an already-installed PAK that supports partial fulfillment". Once you have selected
that option, select the existing PAK code from the drop-down menu.
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6 Click the Next button. If prompted for your Cisco.com account information, enter the username and
password you entered when you registered at Cisco.com.

7 Click the Ok button. The Fulfill Licenses section appears.

8 The licenses within the PAK are listed by SKU name. The numbers of each license are categorized under
a number of headings to indicate how many have been fulfilled and how many are remaining.

You can specify the number of licenses you want to fulfill by selecting Fulfill in the Actions column for
that license type. The Fulfill Licenses window appears. In this window you can specify the count in the
Fulfill column, and click Save then click OK to close the window. The updated count now appears in the
Fulfill column of the Fulfill Licenses table.

Some PAKs are not eligible for partial fulfillment.Important

If licenses are listed as "Fulfilled" (under "Before Fulfillment" in the Fulfill Licenses table), those licenses
have been fulfilled by this or another Cisco Prime License Manager.

Note

Once you have fulfilled your licenses as selected, you may wish to click the Run Compliance Check
button to ensure that you are in compliance.

Note

9 Click the Next button to review your changes. If you are not satisfied with your changes, click Previous
to return to the Fulfill Licenses section. If you are satisfied with the changes, click Next to move to the
next section.

10 Clicking Next in the Fulfill Licenses section opens the Transaction Options and License Agreement section.
In this section, you may enter a description (optional). You may also associate this transaction with a saved
license summary by selecting that option and then selecting the name of the license summary from the
drop-down list.

11 Select the checkbox to accept the conditions of the End User License Agreement.

12 Click the Finish button.

13 Upon successful completion of the e-Fulfillment process, the new fulfillment appears in the License
Fulfillment table.

Adjust PAK fulfillment

In e-Fulfillment mode, you can perform partial fulfillment of a particular PAK that has already been partially
fulfilled on that Cisco Prime License Manager using the following procedure:

1 In the Licenses > Fulfillment page, in the License Fulfillment table, select the PAK from the list under
the PAK column.

An edit (pencil) icon denotes PAKs which support partial fulfillment.Note

2 The PAK Details window opens, showing the original number of licenses in the PAK. SelectAdjust PAK
Fulfillment to retrieve the current status of the PAK.
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3 If prompted, enter your Cisco.com username and password (the information entered when you registered
at Cisco.com).

4 You can specify the number of licenses you want to fulfill by selecting Fulfill in the Actions column for
that license type. The Fulfill Licenses window appears. In this window you can specify the count in the
Fulfill column, and click Save then click OK to close the window. The updated count now appears in the
Fulfill column of the Fulfill Licenses table.

5 You have the option of entering a description in the Transaction Options field. This allows you to track
this transaction.

6 Once you have adjusted your PAK fulfillment numbers, click the Update PAK Fulfillment button.

Fulfillment numbers can only be increased, never decreased.Note

Manual Fulfillment

Manual fulfillment requires additional steps to perform license fulfillment. In situations where internet
connectivity is not available, Manual fulfillment is the only method available. Manual fulfillment is also
necessary for license migration, as described below:

1 Migrate existing licenses (if applicable) into Cisco Prime License Manager. To migrate existing licenses,
see Migrate Licenses to Cisco Prime License Manager, on page 32

2 Once any existing licenses have been migrated, acquire new licenses using the following procedure:
License Planning, on page 42.

Migrate Licenses to Cisco Prime License Manager
This section describes the different migration paths you can follow using Cisco Prime License Manager.

A standard product is any product type supported by Cisco Prime License Manager other than Cisco Unified
Communications Manager or Cisco Unity Connection.

Note

The migration path you follow depends upon a number of factors (For example: the product type, whether
servers contain data from a previous version, etc). The following flow charts provide a guide for the decisions
that must be made to successfully complete your migration. For a broader view of the migration process, see
the release notes for the product instance in question.

If Cisco Prime License Manager is in demo mode, do not create multiple migration requests. Complete
the first migration, including installation of the license, prior to initiating a second migration. If a migration
request results in multiple license files, install all of them, in order, before proceeding.

Note

CiscoUnified CommunicationsManager andCiscoUnity Connection each have uniquemigration processes.Note
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Use the following procedure to plan for migration of product instances whose licenses have not yet been
migrated to Cisco Prime License Manager if e-Fulfillment is enabled.

Standard Product Migration Path with E-Fulfillment Enabled

Procedure

Step 1 From the Licenses > Fulfillment page in Cisco Prime License Manager, choose Fulfillment Options >
Migrate Licenses.
The Migrate Licenses to Cisco Prime License Manager wizard window appears.

Step 2 From the Choose Product Type section, choose the type of product to upgrade from the drop-down menu
and click Next.
The Choose Product Instances section appears.

Step 3 From the Available Product Instances window, choose a product instance and click the arrow to move it to
the Product Instances to Migrate window.
Click Next.

The Licenses to be Migrated dialog box opens.
Step 4 From the table, you can reduce (but not increase) your license counts in the Licenses to Migrate column.

You may also choose to run a compliance check by clicking Run Compliance Check, or reset the license
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values by clicking Reset Values. Click OK to close the dialog box and then click Next to move on to the
Summary and Next Steps section.

Step 5 Specify an optional description for the transaction. Read the End User License Agreement and click Finish
& Generate Request.

Step 6 Enter your Cisco user ID in the Cisco.com (CCO) User ID field.
The request is electronically submitted, and processed immediately. Your licenses are installed automatically.

Standard Product Migration Path with E-Fulfillment Disabled
Use the following procedure to plan for migration of product instances whose licenses have not yet been
migrated to Cisco Prime License Manager if e-Fulfillment is disabled.

Procedure

Step 1 From the Licenses > Fulfillment page in Cisco Prime License Manager, choose Fulfillment Options >
Migrate Licenses.
The Migrate Licenses to Cisco Prime License Manager wizard window appears.

Step 2 From the Choose Product Type section, choose the type of product to upgrade from the drop-down menu
and click Next.
The Choose Product Instances section appears.

Step 3 In the Available Product Instances window, choose a product instance and click the arrow to move it to the
Product Instances to Migrate window.
Click Next.

The Licenses to be Migrated dialog box opens.
Step 4 From the table, you can reduce (but not increase) your license counts in the Licenses to Migrate column. You

may also choose to run a compliance check by clicking the Run Compliance Check button, or reset the license
values by clicking the Reset Values button. ClickOK to close the dialog box and then click Next to move on
to the Summary and Next Steps section.

Step 5 In the Summary and Next Steps section, you can view and save a summary of the changes you made. To view
the summary, click View Summary. A default name for the summary also appears in the Name field using
the format <productname>-migrate-<date-time-stamp> format. Instructions for placing your order and fulfilling
your licenses also appear in this section. Click Finish & Generate Request.
The License Migration Request and Next Steps window appears.

Step 6 Copy the selected text to your clipboard or click Save it to a file on your computer.
Step 7 Choose License Migration Portal under Step 2 and paste the copied text in the designated field or select the

saved file from your computer.
Step 8 Click Close to return to the License Fulfillment page.
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Cisco Unified Communications Manager Migration Path
The following flow chart will aid you in migrating Cisco Unified Communications Manager licenses to Cisco
Prime License Manager:

Figure 2: Unified CM Migration Flow Chart

Use the following procedure to plan for migration of all Unified Communication product instances whose
licenses have not yet been migrated to Cisco Prime License Manager if e-Fulfillment is disabled.
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Procedure

Step 1 From the Licences > Fulfilment page in Cisco Prime License Manager, click Fulfillment Options >Migrate
Licenses.

Step 2 The Migrate Licenses to Cisco Prime License Manager wizard window appears. The first step involves
choosing the product type. From the Choose Product Type section, select Unified CM from the drop-down
menu. The migration process is outlined in this section, and is dependent on the type of product you select.
Click Next.

Step 3 The Choose Product Instances section appears. To upgrade a product instance, select it in the Available Product
Instances window and click the arrow to move it to the Product Instances to Migrate window.

By default, only product instances containing license data from a previous version of Cisco Unified
Communications Manager are displayed in the Available Product Instances table. If the product
instance you upgraded does not appear in the list, click the “Show additional Unified CM product
instances” check box. Selecting this check box adds to the list those product instances that contain
no prior license data and those that were included in prior license migration requests.

Note

Click Next.

Step 4 The License Counts section appears. The Summary of Pre-Upgrade Product Instance Data table lists the
product instances you selected in the previous step. This table cannot be edited. Below the table are a number
of fields that require input:

InputField

An estimate of the number of public space phones. Public space phones do
not have users assigned and are typically placed in shared workspaces, lobbies
and meeting rooms. These phones generally require lower level licenses, so
providing an estimate of the number of these phones in your deployment will
help Cisco more accurately determine your license requirements.

Public Space Phones

A case number assigned if the report was sent to Cisco Licensing SupportCase Numbers (Optional)

Click the Upload Report button to open the Upload License Count Utility
Report dialog box. Click the Browse button to select the report file and then
click Upload Report.

License Count Utility Reports
(Optional)

The MAC addresses from the original servers that were upgraded. These
MAC addresses can be used to look up the licenses that were registered on
those product instances.

MAC Addresses (Optional)

Once you have selected the appropriate option and entered the necessary information, click Next.
Step 5 The Summary and Next Steps section appears. In this section you must indicate how the upgrade was ordered:

• Upgraded using one or more service contracts

• Purchased the upgrade

If you select "Upgraded using one or more service contracts", enter the UCSS/ESW Contract Numbers. If
you select "Purchased the upgrade", enter the Sales Order Numbers.

Step 6 Enter your Cisco user ID in the Cisco.com (CCO) User ID field.
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Company Name and the field used to capture additional information are optional. However; if you enter the
company name, it is used in the subject line of the email and is included in the name of the zip file.

A default name for the summary also appears in the Name field using the format
<productname>-migrate-<date-time-stamp> format. Instructions for placing your order and fulfilling your
licenses also appear in this section. Click Finish & Generate Request.

Step 7 The License Migration Request and Next Steps window appears. Download the License Migration Request
zip file to your PC.
Email the License Migration Request to Cisco licensing support using the link provided.

Click Close to return to the License Fulfillment page.
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Cisco Unity Connection Migration Path
The following flow chart will aid you in migrating Cisco Unity Connection licenses to Cisco Prime License
Manager:

Figure 3: Unity Connection Migration Flow Chart

Use the following procedure to plan for migration of all Unity Connection product instances whose licenses
have not yet been migrated to Cisco Prime License Manager.
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Procedure

Step 1 From the Licenses > Fulfillment page in Cisco Prime LicenseManager, click Fulfillment Options >Migrate
Licenses.

Step 2 The Migrate Licenses to Cisco Prime License Manager wizard window appears. The first step involves
choosing the product type. From the Choose Product Type section, selectUnityConnection from the drop-down
menu. The migration process is outlined in this section, and is dependent on the type of product you select.
Click Next.

Step 3 The Choose Product Instances section appears. To upgrade a product instance, select it in the Available Product
Instances window and click the arrow to move it to the Product Instances to Migrate window.
Click Next.

Step 4 The License Counts section appears. This section prompts you to choose between two options relating to
Cisco Unified Workshop Licenses (CUWL):

InputOption

Click Next to move on to the Summary and Next Steps section.I have CUWL licenses to be
migrated

The Licenses to be Migrated dialog box opens. From the table, you can
reduce (but not increase) your license counts in the Licenses to Migrate
column. You may also choose to run a compliance check by clicking the
Run Compliance Check button, or reset the license values by clicking the
Reset Values button. ClickOK to close the dialog box and then click Next
to move on to the Summary and Next Steps section.

I do not have CUWL licenses
to be migrated.

Step 5 The Summary and Next Steps section appears. The option you selected in Step 4 determines the information
displayed in this section.
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DescriptionOption

In this section you must indicate how the upgrade was ordered:

- Upgraded using one or more service contracts

- Purchased the upgrade

If you select Upgraded using one or more service contracts, enter the UCSS/ESW
Contract Numbers.

If you select Purchased the upgrade, enter the Sales Order Numbers.

Enter your Cisco user ID in the Cisco.com (CCO) User ID field.

Company Name and the field used to capture additional information are optional.
However; if you enter the company name, it is used in the subject line of the email
and is included in the name of the zip file.

A default name for the summary also appears in the Name field using the format
<productname>-migrate-<date-time-stamp> format. Instructions for placing your
order and fulfilling your licenses also appear in this section. ClickFinish&Generate
Request.

The License Migration Request and Next Steps window appears. Download the
License Migration Request zip file to your PC.

Email the License Migration Request to Cisco licensing support using the link
provided.

Click Close to return to the License Fulfillment page.

I have CUWL licenses
to be migrated

1 Specify an optional description for the transaction. Read the end User License
Agreement and select the check box to confirm.

2 Click Finish and Generate.
3 Enter your Cisco.com login and click OK.
4 The request is electronically submitted, processed immediately, and your licenses

are installed automatically.

I do not have CUWL
licenses to be migrated
and e-Fulfillment is
enabled

In this section you can view and save a summary of the changes you made. To view
the summary, click View Summary. A default name for the summary also appears
in the Name field using the format <productname>-migrate-<date-time-stamp>
format. Instructions for placing your order and fulfilling your licenses also appear
in this section. Click Finish & Generate Request.

The License Migration Request and Next Steps window appears. Copy the selected
text to your clipboard or click Save it to a file on your computer.

Select License Migration Portal under Step 2 and paste the copied text in the
designated field or select the saved file from your computer.

Click Close to return to the License Fulfillment page.

Only e-Migration transactions are accessible on the License Fulfillment
page. Since this is a manual Migration, the migration plan is accessible
only on the License Planning page.

Note

I do not have CUWL
licenses to be migrated
and e-Fulfillment is
disabled
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Alternate Cisco Unified Communications Manager Migrations Path
The following are alternate migration paths, available for use under specific circumstances:

• Upgrades completed without the License Count Utility (LCU) Report

• Fresh install with imported pre-9.x data

Upgrades completed without LCU Report

The Cisco Prime License Manager Migration Utility relies on DLU and license usage retained during the
upgrade.

In situations where a product is upgraded to 10.x without running License Count Utility on a pre-9.x version.
Please contact the Cisco licensing office and have the license file reissued if changes are required.

Fresh install with imported pre-9.x data

Amigration may be required following a fresh install in situations where pre-9.0 DLU or license information
is not available in Release 10.x VM. This may occur when:

• UC Release 8.6 needs to be upgraded as a new VM, with phone data exported

• A new Release10.x VM is created, with phone data imported

The following procedure enables you to perform a migration after a fresh install. This procedure requires that
an LCU report be run against pre-upgrade product instance, if still accessible, or that MAC addresses of the
pre-upgrade product instances be available.

Procedure

Step 1 From the Licenses > Fulfillment page in Cisco Prime LicenseManager, click Fulfillment Options >Migrate
Licenses.

Step 2 The Migrate Licenses to Cisco Prime License Manager wizard window appears. The first step involves
choosing the product type. From the Choose Product Type section, select the type of product to upgrade and
the version from the drop-down menus. Click Next.

Step 3 The Choose Product Instances section appears. Check the checkbox next to Show additional Unified CM
product instances. Selecting this option allows you to view products without prior version data.

Step 4 To migrate a product instance, select it in the Available Product Instances window and click the arrow to
move it to the Product Instances to Migrate window. Click Next.

Step 5 The Additional Information Will Be Required window appears. Once you have read the contents of the
window, click Continue to close the window.

Step 6 The License Counts section appears. Enter the following information

• The number of public space phones in the Public Space Phones field

• Case Numbers

• License Count Utility Reports - select the zip file using the Upload Report button

• The MAC address in the MAC Addresses field
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Click Next.
Step 7 The License Migration Request and Next Steps window appears. Download the License Migration Request

zip file to your PC.
Step 8 Email the License Migration Request to Cisco licensing support using the link provided.
Step 9 Click Close to return to the License Planning page.

Licensing Migration Support
Product licensing has a grace period from the time that users are configured on the system. For Cisco Unified
Communications Manager and Unity Connection, the grace period is 60 days.

The Global Licensing Operations (GLO) Team is available 24 x 7 x 365 and has knowledgeable agents that
can help process your request and route it to the team best able to assist you. Expect a response within 48-72
hours

To obtain migration support, select one of the following options:

• Open your service request through the web: https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case

• Open any service request through licensing@cisco.com (include Cisco.com user ID)

• Open a service request by telephone using country-specific numbers: http://www.cisco.com/en/US/
support/tsd_cisco_worldwide_contacts.html

New License Planning and Fulfillment
Use the following procedures to plan your licensing needs and electronically fulfill your licenses.

License Planning
Use the following procedure to plan the addition of new licenses.

Procedure

Step 1 From the Licenses > Planning page, click Create an Add Licenses Plan.
The Create an Add Licenses Plan wizard window appears.

Step 2 From the Choose Product section, choose the product type and license version of the product to which you
will be adding a licence. Click Next.

Step 3 From the License Counts section, adjust the number of licenses that will be allocated to each type of license
and click Save to save your changes for that license type. You may also choose to run a compliance check
by clicking Run Compliance Check, or reset the license values by clicking Reset Values. After the number
of licenses has been set, click Next.
Clicking the arrow next to each license type reveals additional information about that license type.
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A window appears to indicate whether the compliance check passed or failed.
Step 4 If your compliance check fails, you can return toLicense Counts to make additional changes. If the compliance

check passed, click Continue to move to the next section.
Step 5 In Summary and Next Steps section, you can view and save a summary of the changes you made. You can

also enter your own summary name and description.
Step 6 To view the summary, click View Summary. The Save Summary in Cisco Prime License Manager option

is selected by default. A default name for the summary also appears in the Name field using the format
<product-type>-add-<date-time-stamp> format. Instructions for placing your order and fulfilling your licenses
also appear in this section.

Step 7 Click Finish

What to Do Next

1 Place your order: Purchase your licenses or use your service contract to get a PAK.

2 Fulfill your licenses: Enter your PAK into the License Fulfillment screen of Cisco Prime LicenseManager
and, through the e-Fulfillment process, fulfill your licenses. Cisco Prime License Manager communicates
with Cisco licensing servers and your new licenses will be installed and ready to use.

Configure License Fulfillment Electronically
Complete the following procedure to electronically fulfill your licenses.

Before You Begin

Create a licenses plan.

Procedure

Step 1 From the Cisco Prime License Manager main menu, select Licenses > Fulfillment.
The License Fulfillment page opens.

Step 2 In eFulfillment mode, click Fulfill Licenses from PAK.
The Fulfill Licenses from PAK window appears.

Step 3 Choose the Add licenses from a new PAK option and enter the Product Authorization Key (PAK) code.
If you have previously entered PAKs in Cisco Prime License Manager, you may select the second option,
"Add licenses from an already-installed PAK that supports partial fulfillment". After you have chosen that
option, select the existing PAK code from the drop-down menu.

Step 4 Click Next.
Step 5 If prompted for your Cisco.com account information, enter the username and password you entered when you

registered at Cisco.com.
Step 6 Click OK.

If there are licenses remaining to be fulfilled (and the PAK username and password are validated), the Fulfill
Licenses section appears.

Step 7 The licenses within the PAK are listed by SKU name. The numbers of each license are categorized under a
number of headings to indicate how many have been fulfilled and how many are remaining.
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You can specify the number of licenses you want to fulfill by selecting Fulfill in the Actions column for that
license type. The Fulfill Licenses window appears. In this window you can specify the count in the Fulfill
column, and click Save, then click OK to close the window. The updated count now appears in the Fulfill
column of the Fulfill Licenses table.

Some PAKs are not eligible for partial fulfillment. These PAKs are packaged together, so they
can only be fulfilled at a single Cisco Prime License Manager. For example, an NFR
(not-for-resale) order is sold as a package with 20 CUWLPro Unified CM and Unity Connection
licenses and five TelePresence Room licenses.

Important

If licenses are listed as "Fulfilled" (under "Before Fulfillment" in the Fulfill Licenses table), those
licenses have been fulfilled by this or another Cisco Prime License Manager.

Note

Once you have fulfilled your licenses as selected, you may wish toRunCompliance Check to ensure
that you are in compliance.

Note

Step 8 Click Next to review your changes. If you are not satisfied with your changes, click Previous to return to the
Fulfill Licenses section. If you are satisfied with the changes, click Next to move to the next section.

Step 9 Click Next in the Fulfill Licenses section.
Step 10 In the Transaction Options and License Agreement section, you may enter a description (optional). You may

also associate this transaction with a saved license summary by selecting that option and then selecting the
name of the license summary from the drop-down list.

Step 11 Indicate that you accept the conditions of the End User License Agreement.
Step 12 Click Finish.

Upon successful completion of the e-Fulfillment process, the new fulfillment appears in the License Fulfillment
table.

Upgrade Existing Licenses
There are three types of license upgrades:

• License feature upgrades

• License version upgrades

• License feature and version upgrades

The content of the PAK determines whether a license can be upgraded by feature or version.Note

Use the following procedure to fulfill a major version upgrade using eFulfillment.

Procedure

Step 1 From the Cisco Prime License Manager main menu, select Licenses > Fulfillment. The License Fulfillment
page opens.

Step 2 In eFulfillment mode, click the Fulfill Licenses from PAK button. The Fulfill Licenses from PAK window
appears.

Step 3 Select the Add licenses from a new PAK option and enter the Product Authorization Key (PAK) code.
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If you have previously entered PAKs in Cisco Prime License Manager, you may select the second option,
"Add licenses from an already-installed PAK that supports partial fulfillment". Once you have selected that
option, select the existing PAK code from the drop-down menu.

Step 4 Click theNext button. If prompted for your Cisco.com account information, enter the username and password
you entered when you registered at Cisco.com.

Step 5 Click the Ok button. If there are licenses remaining to be fulfilled (and the PAK username and password are
validated), the Fulfill Licenses section appears.

Step 6 The licenses within the PAK are listed by SKU name. The numbers of each license are categorized under a
number of headings to indicate how many have been fulfilled and how many are remaining.
You can specify the number of licenses you want to fulfill by selecting Fulfill in the Actions column for that
license type. The Fulfill Licenses window appears. In this window you can specify the license version, feature,
or both, and click Save then click OK to close the window. The updated count now appears in the Fulfill
column of the Fulfill Licenses table.

Some PAKs are not eligible for partial fulfillment. These PAKs are packaged together, so they
can only be fulfilled at a single Cisco Prime License Manager. For example, an NFR
(not-for-resale) order is sold as a package with 20 CUWLPro Unified CM and Unity Connection
licenses and five TelePresence Room licenses.

Important

If licenses are listed as "Fulfilled" (under "Before Fulfillment" in the Fulfill Licenses table), those
licenses have been fulfilled by this or another Cisco Prime License Manager.

Note

Once you have fulfilled your licenses as selected, youmaywish to click theRunCompliance Check
button to ensure that you are in compliance.

Note

Step 7 Click the Next button to review your changes. If you are not satisfied with your changes, click Previous to
return to the Fulfill Licenses section. If you are satisfied with the changes, click Next to move to the next
section.

Step 8 Clicking Next in the Fulfill Licenses section opens the Transaction Options and License Agreement section.
In this section, you may enter a description (optional). You may also associate this transaction with a saved
license summary by selecting that option and then selecting the name of the license summary from the
drop-down list.

Step 9 Select the checkbox to accept the conditions of the End User License Agreement.
Step 10 Click the Finish button.
Step 11 Upon successful completion of the e-Fulfillment process, the new fulfillment appears in the License Fulfillment

table.

Other Fulfillment Options
Next to the Fulfill Licenses from PAK option on the License Fulfillment page, there is another option entitled
"Other Fulfillment Options".

InManual Fulfillment mode, selecting the drop-down arrow under this option reveals only one option: Generate
License Request.

In eFulfillment mode, selecting the drop-down arrow under this option reveals three options:

• Fulfill Licenses from File

• Generate License Request

• Retrieve Fulfilled Licenses
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Fulfill Licenses From File

To fulfill licenses from a file on your PC:

1 Select Other Fulfillment Options > Fulfill Licenses from File.
2 The Install License File window opens. Click the Browse button to locate the file on your PC. Select the

file and click Open.
3 You can add a description and associate the transaction with a saved license plan (optional).
4 Click the Install button to install the license file.

Generate License Request

To obtain a new license (using Manual fulfillment), you must first generate a license request through the
Licenses > Fulfillment page, and then use the information generated to submit a request. You will then receive
your license file via email. Use the following procedure to generate a license request.

1 Log in to Cisco Prime License Manager.
2 From the Licenses > Fulfillment page, select Generate License Request from the drop-down list under

Other Fulfillment Options.
3 The License Request and Next Steps window appears. Copy the selected text to your clipboard or click

Save it to a file on your PC.

Once you have your license request information saved either to your clipboard or to your computer, you
need to access the Cisco License Registration site and paste it into the appropriate field. When you receive
your license file via email, install your new license file in Cisco Prime License Manager using the New
License Planning and Fulfillment, on page 42 procedure.

Remember

Retrieve Fulfilled Licenses

The "Retrieve Fulfilled Licenses" option is exclusive to e-Fulfillment. This feature connects to the Cisco
licensing servers to retrieve and install the licenses that have been fulfilled for this Prime License Manager.
This feature is useful if you wish to synchronize your Cisco Prime License Manager with the Cisco back
office with regard to licenses that have been fulfilled.

Use the following procedure to retrieve fulfilled licenses:

1 Log in to Cisco Prime License Manager.

2 Select Licenses > Fulfillment.

3 If not already selected, click the Enable button to enable e-Fulfillment.

4 Under Other Fulfillment Options, select Retrieve Fulfilled Licenses. The Retrieve Fulfilled Licenses
window appears.

5 Enter your Cisco Username and Password. You can add a description (optional) in the Transaction
Description field.

6 Click the Retrieve and Install Licenses button.

7 Your Cisco Prime License Manager is synchronized with the Cisco back office and all licenses currently
fulfilled are installed.
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C H A P T E R  4
Administration

The following sections provide information on using theCisco Prime License Manager administrative tools.

• Backup/Restore, page 47

• License Definitions, page 48

• Security Updates, page 48

• License Rehost, page 49

• Accessing Diagnostic Logs, page 50

• Reset OS Administrator and Security Passwords, page 50

Backup/Restore
Use the following procedure to perform a backup and restore of Cisco Prime License Manager.

Procedure

Step 1 From the main menu, select Administration > Backup/Restore.
Step 2 The Backup/Restore page opens. Enter the following information:

• IP Address/Hostname

• Username

• Password

• Directory

At this point, you can click theTest Connection button to test your connection.Note

Step 3 To perform a backup, click the Run Backup button.
Amaximum of two backups are stored. Creating a third backup will overwrite the oldest backup.Note

Step 4 To restore, select the file you wish to restore and click the Run Restore button.
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License Definitions
License definitions contain information about the license types managed by Cisco Prime License Manager.
This file should be updated prior to upgrading any of your product instances to a new version or before adding
a product instance of a new type. The Administration > License Definitions page provides the following
information for the currently installed file:

• File name

• Version

• Date Installed

You can click the Check for Latest Version link to access the Download Software site. From this site, you
can locate the latest release and download it.

Once downloaded, a new license definition file can be installed using the following procedure:

Procedure

Step 1 Access the License Definitions page from the main menu by selectingAdministration > License Definitions.
Step 2 Click theCheck for Latest Version link to access the Download Software site. Download the desired license

definition file to your computer.
Step 3 Click the Install New License Definition File button. The Install License Definitions window appears.
Step 4 Click the Browse button to select the license definition file you just downloaded, then click Install.

Security Updates
Security updates may be required at Cisco Prime LicenseManager periodically to permit electronic operations
with the Cisco License Office.

Security updates will be available at the Cisco Software Download Center: http://software.cisco.com.

Use the following procedure to perform security updates through CLI:

Procedure

Step 1 Enter the license management security update command.
Step 2 EnterDirectory, Server, User Name, and Password information when prompted, as shown in the following

example:

Example:
Directory: /users/bsmith/security_update/update

Server: se032c-94-61
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User Name: bsmith

Password: ********

Step 3 You are then asked to select the security update, as shown in the following example:

Example:
Available options for security update in "se032c-94-61:/users/bsmith/security_update/update":

1) SecUpd_v1.upd

q) quit

Step 4 Select option 1 to download the security update. The following messages appear:

Example:
Installing security update...

Continue (y/n)?

Step 5 Select y to continue the security update.
When the update is complete, the following message appears:

Security update installed.

License Rehost
Licenses are fulfilled to a specific Cisco Prime License Manger. If you require licenses to be moved to a new
Cisco Prime License Manager, they will be need to be rehosted.

A rehost may be required if:

• A hardware failure occurred and new hardware is required for Cisco Prime License Manager

• Multiple Cisco Prime LicenseManagers are desired and a subset of fulfillment licenses need to be moved
to a new Cisco Prime License Manager

License rehosts or transfers can be requested at www.cisco.com/go/license and do not require Global Licensing
Operations (GLO) support.

In order to use the rehost portal, you must use the same Cisco.com user ID that initially ordered or fulfilled
the licenses.

Note

To perform a rehost, the license registration from the source machine as well as license request or license
registration from the target machine is required.

Use the following procedure to perform a license rehost.
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Procedure

Step 1 From Product License Registration (https://tools.cisco.com/SWIFT/LicensingUI/Quickstart), chooseLicenses.
Step 2 Under the License ID tab of a particular device, choose the license(s) that you want to rehost.
Step 3 In the pop-up that appears, choose Rehost/Transfer.
Step 4 In the Quantity to Assign field, enter the number of licenses you want to transfer.
Step 5 In the License Request field, enter the License Request from the Cisco Prime License Manager of the target

device.
Step 6 Click Next.
Step 7 In the Review screen, review your selections.
Step 8 Enter your email address, choose your name from the drop-down list next to End User, and indicate that you

agree with the Terms of the License.
Step 9 Click Submit.
Step 10 The rehosted license is emailed to you. It must then be manually installed on Cisco Prime License Manager.

The license can also be downloaded to your machine by clicking Download Target on the License
Request Status window and choosing the download location.

Note

Accessing Diagnostic Logs
Use the following procedure to run diagnostic logs in Cisco Prime License Manager.

Procedure

Step 1 From the main menu in Cisco Prime License Manager, select Administration > Diagnostic Logs.
Step 2 The Diagnostic Logs screen appears. Under the Log Settings tab, set the log level to Debug for both "Cisco

Prime License Manager core services: and "Communication with product instances". Click Save to save your
changes.

Step 3 Select the Download Logs tab and select the date and time range to include in your log file (the time period
during which the issue occurred). Click the Generate Log File button.

Step 4 The link to the log file appears below the Generate Log File button. Click the link to download the log file to
your PC and then send the log file to Cisco: licensing@cisco.com

Reset OS Administrator and Security Passwords
To reset a password, you must connect to the system through the system console. You cannot reset a password
when you connect to the system through a secure shell session.
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During this procedure, you must remove and then insert a valid CD or DVD in the disk drive to prove that
you have physical access to the system.

Note

Procedure

Step 1 Log in to the system with the following username and password:

• Username: pwrecovery

• Password: pwreset
TheWelcome to platform password reset window appears.

Step 2 Press any key to continue.
Step 3 If you have a CD or DVD in the disk drive, remove it now.
Step 4 Press any key to continue.

The system tests to ensure that you removed the CD or DVD from the disk drive.

Step 5 Insert a valid CD or DVD into the disk drive.
For this test, you must use a data CD, not a music CD. The system tests to ensure that you have
inserted the disk.

Note

Step 6 After the system verifies that you have inserted the disk, you are prompted to enter one of the following
options to continue:

• Enter a to reset the Administrator password.

• Enter s to reset the security password.

• Enter q to quit.

Step 7 Enter a new password of the type that you chose.
Step 8 Reenter the new password.

The password must contain at least six characters. The system checks the new password for strength. If the
password does not pass the strength check, you are prompted to enter a new password.

Step 9 After the system verifies the strength of the new password, the password is reset. You are prompted to press
any key to exit the password reset utility.
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C H A P T E R  5
Setup

• About Window, page 53

• Dashboard View Settings, page 54

• Licenses View Settings, page 55

• License Usage Page Settings, page 55

• License Planning Page Settings, page 57

• License Fulfillment Page Settings, page 58

• Product Instances View Settings, page 67

• Administration View Settings, page 70

About Window
DescriptionSetting

The About dialog box contains the Cisco Prime License Manager
version number, license definition version, and Registration ID
number.

This information can be used for re-hosting. Re-hosting is
the process that customers must follow to move licenses
from one instance of Cisco Prime License Manager to
another. Licenses that have already been issued and fulfilled
in one instance of Cisco Prime LicenseManager are moved
to a new or different instance of Cisco Prime License
Manager through the re-hosting process. As part of this
process, it is suggested that the version number and
Registration ID number be recorded in some fashion
following any installation of Cisco Prime LicenseManager.

Note

About
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Dashboard View Settings
DescriptionSetting

Overview section

The total number of product instances managed by Cisco Prime
LicenseManager. Clicking Product Instances takes you to the Product
Instances page.

Product Instances

The date of the last license update. Clicking Last License Update
takes you to the Licenses > License Fulfillment page.

Last License Update

The date of the last successful synchronization. Clicking Last
Synchronization takes you to the Product Instances page where you
can view the Synchronization Status and Last Successful
Synchronization for each product instance. You can also perform a
synchronization from this page by clicking the Synchronize Now
button.

Synchronization occurs when Cisco Prime LicenseManager
collects up-to-date licensing information for all license types
in the system.

Note

Last Synchronization

License Alerts section

License types that are non-compliantType

Provides information about the alert (for example, insufficient
licenses or when a license is due to expire)

Status

License Usage section

Specifies the product typeType

The number of licenses allocated to each of those product typesRequired

Product Instance Alerts section

Specifies the product nameName

Provides information about the productStatus

The date and time of the last successful synchronizationLast Synchronization
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Licenses View Settings
The Licenses view contains three pages that allow you to view licensing information and configure product
licenses:

• License Usage Page Settings, on page 55

• License Planning Page Settings, on page 57

• License Fulfillment Page Settings, on page 58

License Usage Page Settings
The License Usage page provides three distinct views of how licenses are being used:

• Table View

• Chart View

• History

In both Table and Chart views, you have the option of synchronizing the licenses by clicking the
Synchronize Now button.

Note

DescriptionSetting

Table View tab

The name of the license types supported within the product scope.
For more information, click on a particular license type in the Type
column to open a detailed license type page.

Type

The product typeProduct Type

The number of licenses required by the product instances in order
to deliver the services you have provisioned on those servers.

Required

The number of licenses currently installedInstalled

The difference between the number of Required and Installed
licenses. The numbers in this column are color-coded to represent
the state of unused licenses for a particular license type.

If the number is red, the number of licenses is considered
insufficient. If the number is black, the number of licenses is
considered to be in compliance.

Available
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DescriptionSetting

The license status (ex: “Temp Licenses Nearing Expiration”, “In
Compliance”)

Status

Synchronizes Cisco Prime License Manager with the product
instances to obtain the most up-to-date licensing information for
all license types in the system

Synchronize Now button

Chart View tab

The License Type drop down menu allows you to select the type
of license you wish to view.

License Type

The Installed/Borrowed licenses are categorized as:

• Installed

• Borrowed from Upper Tier

Not all products support
tiering

Important

Installed/Borrowed

The Required/Loaned licenses are categorized as:

• Requested

• Loaned to Lower Tier

Moving your mouse over the bars in the chart reveals the
number of licenses installed/borrowed or required/loaned

Note

Required/Loaned

Synchronizes Cisco Prime License Manager with the product
instances to obtain the most up-to-date licensing information for
all license types in the system

Synchronize Now button

History tab

You can download the usage history for your licenses into a csv
file that can be opened in a spreadsheet application. Usage data is
collected at every synchronization with product instance and with
each action that changes license usage.

History tab

Allows you to select the start and end date for the period of time
you wish to cover.

Date Range

Specifies the type of product instanceProduct Type

Clicking the Generate File button creates a usage history file for
the product type selected. A link to the file appears at the bottom
of the screen. When you click on the link, you have the option of
opening the file or saving it to your computer.

Generate File button
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DescriptionSetting

License Usage details page

Clicking on a license in the Table View in the License Usage page opens this License Usage details
page

Note

The License Description section provides a description of that
license type. There is also a link provided to view descriptions of
all license types on Cisco.com.

License Description section

The Usage Chart section provides a graphical representation of how
many of that particular license type are available, and of those, how
many are installed or borrowed from the upper tier.

It also indicates how many of that license type are being used, and
of those, how many are requested or loaned to the lower tier.

Usage Chart section

The Usage by Instance section lists the systems that are using that
particular license type, and identifies the product type of the system,
release version, and the number of licenses required for each of
those systems.

Usage by Instance section

The Installed Licenses by Type section distinguishes between
Permanent and Temporary licenses, the number of licenses that
each is limited to, and the expiry date for the temporary licenses.

Installed Licenses by Type section

License Planning Page Settings
DescriptionSetting

License Planning page

Specifies the name of the license plan

Selecting a license plan name from the list in the History table opens
the Details window for that license plan. This window contains the
following information:

• Name (editable)

• Description (editable)

• Type

• Created Date

• Summary (includes a View Summary link that provides
summary information for that license plan)

Name

Provides a brief description of the license planDescription
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DescriptionSetting

Specifies the license plan type: Migration or AddType

Specifies the license plan creation dateCreation Date

The Action column provides a Delete button to delete a license planAction

Clicking the Create an Add Licenses Plan button opens the Create
an Add Licenses Plan wizard. For instructions on how to complete
the Create an Add Licenses Plan wizard, see the Cisco Prime License
Manager User Guide.

Create an Add Licenses Plan button

Create an Add Licenses Plan page

From the Choose Product section of the Create an Add Licenses Plan
window, you can select (from the drop-down menus) the Product
Type and the License Version to which you want to add licenses.

Choose Product section

From the Specify License Counts section of the Create an Add
Licenses Plan window, you can adjust the number of licenses to be
allocated to each type of license and save your changes for that license
type.

You may also choose to run a compliance check by clicking the Run
Compliance Check button, or reset the license values by clicking the
Reset Values button.

Specify License Counts section

From the Summary and Next Steps section of the Create an Add
Licenses Plan window, you can view and save a summary of the
changes youmade in the Choose Product and Specify License Counts
sections.

The Save Summary in Cisco Prime License Manager option is
selected by default. A default name for the summary also appears in
the Name field using the format
<product-type>-add-<date-time-stamp> format.

Summary and Next Steps

License Fulfillment Page Settings
Table 3: License Fulfillment Page

DescriptionSetting

Allows you to enable e-Fulfillment. This is the default state.Enable button

Allows you to disable e-Fulfillment. If e-Fulfillment is disabled, by
selecting the Disable button, onlyManual Fulfillment options are visible.

e-Migration is disabled if e-Fulfillment is
disabled.

Note

Disable button
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DescriptionSetting

Opens the Add/Install Licenses wizard (e-Fulfillment)Fulfill Licenses from PAK button
(e-Fulfillment)

Clicking the Other Fulfillment Options drop-down menu, visible when
e-Fulfillment is enabled, allows you to select:

• Fulfill Licenses from File

• Generate License Request

• Migrate Licenses

• Retrieve Fulfilled Licenses

Only the Generate License Request and Migrate License
options are available under Manual fulfillment.

Note

The Fulfill Licenses from File option opens the Install License File
dialog box.

The Generate License Request option opens the License Request and
Next Steps dialog box.

TheMigrate License option opens the Migrate Licenses to Cisco Prime
License Manager page.

Other Fulfillment options
(e-Fulfillment)

Opens the Install License File pageFulfill Licenses from File button
(Manual Fulfillment)

Drop-down menu, visible when e-Fulfillment is disabled, that allows
you to:

• Generate License Request

• Migrate Licenses

The Generate License Request opens the License Request and Next
Steps dialog box

Other Fulfillment options (Manual
Fulfillment)

Specifies the date of license fulfillmentFulfillment Date

The description, specified by the user in the wizard, of the license
fulfillment

Description

Specifies the type of license fulfillment used (e-Fulfillment or File
Install)

Method

Specifies the PAK ID (in e-Fulfillment mode, the PAK IDs are clickable
links that open the PAK detail window which allows you to adjust PAK
fulfillment for that particular PAK)

PAK
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Table 4: Migrate Licenses to Cisco Prime License Manager

DescriptionSetting

From the Choose New License Version section of the
Migrate Licenses to Cisco Prime License Manager
window, you can select the Product Type and New
License Version from the drop-down menus.

Choose New License Version

From the Choose Product Instances section of the
Migrate Licenses to Cisco Prime License Manager
window, you can upgrade a product instance by
selecting it in the Available Product Instances window
and click the arrow tomove it to the Product Instances
to Upgrade window.

Choose Product Instances

From the License Counts section of the Migrate
Licenses to Cisco Prime License Manager window,
you can view a summary of pre-upgrade product
instance data. This table cannot be edited.

If you selectedUnified CM as your product type, the
following options appear:

• Public Space Phones - An estimate of the
number of public space phones. Public space
phones do not have users assigned and are
typically placed in shared workspaces, lobbies
and meeting rooms. These phones generally
require lower level licenses, so providing an
estimate of the number of these phones in your
deployment will help Cisco more accurately
determine your license requirements.

• Case Numbers (Optional) - A case number
assigned if the report was sent to Cisco
Licensing Support

• License Usage Reports - Allows you to upload
a License Usage Reports from a local drive.

• MAC addresses - TheMAC addresses from the
original servers that were upgraded. TheseMAC
addresses can be used to look up the licenses
that were registered on those product instances.

The MAC Addresses field is only
displayed if pre-upgrade license usage
information is not available. For more
information, see Alternate Cisco
Unified Communications Manager
Migrations Path, on page 41.

Note

License Counts (Unified CM)
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DescriptionSetting

The content of the License Counts section of the
Migrate Licenses to Enterprise License Manager
window depends entirely upon the options you have
selected in previous sections.

If you selected Unity Connection, the following
options appear:

• I have CUWL licenses to be migrated

• I do not have CUWL licenses to be migrated

License Counts (Unity Connection)

From the License Counts section of the Migrate
Licenses to Cisco Prime License Manager window,
you can view a table of the licenses available to
migrate. This table is editable. From the table, you
can reduce (but not increase) license counts in the
Licenses to Migrate column. You can also run a
compliance check by clicking the Run Compliance
Check button, or reset the license values by clicking
the Reset Values button.

License Counts (standard product)
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DescriptionSetting

The content of the Summary and Next Steps section
of the Migrate Licenses to Enterprise License
Manager window depends entirely upon the options
you have selected in previous sections.

If you selected Unified CM as your product type, or
Unity Connection > I have CUWL licenses to be
migrated, the following options appear:

In this section you must indicate how the upgrade
was ordered:

• Upgraded using one or more service contracts

• Purchased the upgrade

If you select Upgraded using one or more service
contracts, enter the UCSS/ESW Contract Numbers.

If you select Purchased the upgrade, enter the Sales
Order Numbers.

The Cisco.com (CCO) User ID field.

Company Name and the field used to capture
additional information are optional. However; if you
enter the company name, it is used in the subject line
of the email and is included in the name of the zip
file.

A default name for the summary also appears in the
Name field using the format
<productname>-migrate-<date-time-stamp> format.
Instructions for placing your order and fulfilling your
licenses also appear in this section. Click Finish &
Generate Request.

The License Migration Request and Next Steps
window appears. Download the License Migration
Request zip file to your PC.

Email the License Migration Request to Cisco
licensing support using the link provided.

Click Close to return to the License Fulfillment page.

Summary and Next Steps (Unified CM or Unity
Connection > I have CUWL licenses to be migrated)
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DescriptionSetting

The content of the Summary and Next Steps section
of the Migrate Licenses to Enterprise License
Manager window depends entirely upon the options
you have selected in previous sections.
If e-Fulfillment is enabled, and you selected Unity
Connection > I do not have CUWL license to be
migrated, the following options appear: In this
section, you can optionally enter a description of the
e-Migration transaction.

Read the End User License Agreement and select the
checkbox to acknowledge the agreement.

Summary and Next Steps (Unity Connection > I do
not have CUWL licenses to be migrated) when
e-Fulfillment/e-Migration is enabled

The content of the Summary and Next Steps section
of the Migrate Licenses to Enterprise License
Manager window depends entirely upon the options
you have selected in previous sections.

If you selected Unity Connection > I do not have
CUWL licenses to be migrated, the following
options appear:

In this section, you can view and save a summary of
the changes you made. To view the summary, click
View Summary. A default name for the summary also
appears in the Name field using the format
<productname>-migrate-<date-time-stamp> format.
Instructions for placing your order and fulfilling your
licenses also appear in this section. Click Finish &
Generate Request.

The License Migration Request and Next Steps
window appears. Copy the selected text to your
clipboard or click Save it to a file on your computer.

Select License Migration Portal under Step 2 and
paste the copied text in the designated field or select
the saved file from your computer.

Click Close to return to the Add or Upgrade Licenses
page.

Summary and Next Steps (Unity Connection > I do
not have CUWL licenses to be migrated) when
e-Fulfillment/e-Migration is disabled

Clicking Finish & Generate Request in the
Summary and Next Steps section of the Migrate
License Manager window initiates the e-Migration.
Enter your Cisco user ID and password. The request
is electronically submitted, and processed
immediately. Your licenses are installed
automatically.

License Migration Request and Next Steps when
e-Fulfillment/e-Migration is enabled
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DescriptionSetting

Clicking the Finish &Generate Request button in the
Summary and Next Steps section of the Migrate
Licenses to Cisco Prime License Manager window
opens the LicenseMigration Request and Next Steps.

You have the option of copying the selected text or
clicking the Save it to a file on your computer link.

License Migration Request and Next Steps when
e-Fulfillment/e-Migration is disabled

Table 5: Add/Install Licenses Wizard

DescriptionSetting

From the Specify PAK section of the Fulfill Licenses from PAKwizard,
you can add licenses from:

• A new PAK

• An already-installed PAK that supports partial fulfillment

Only PAKs that support partial fulfillment are displayed in the
drop-down menu.

Specify PAK

From the Fulfill Licenses section you can choose the licenses in the
PAK that you want to fulfill.

The Fulfill option, under the Actions column, allows you to fulfill a
particular license. Clicking the Fulfill option opens the Fulfill Licenses
window. From that window, you can adjust the number of licenses you
wish to fulfill for a particular license type.

You can also perform a compliance check of your licenses by clicking
the Run Compliance Check button.

To reset the values you have entered, click the Reset Values button.

Fulfill Licenses

From the Review Contents section of the Fulfill Licenses from PAK
wizard, you can review the contents of the PAK. If the PAK supports
partial fulfillment, you can adjust the license installation counts.

Review Contents

From the License Options section of the Fulfill Licenses from PAK
wizard, you can add a description to the transaction or associate it with
a previously generated add or upgrade plan.

Transaction Options and License
Agreement

Table 6: Install License File Dialog Box

DescriptionSetting

Allows you to select a license file from your computer.Browse button
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DescriptionSetting

The Options section of the Install License File dialog box allows you
to add a description and associate your transaction with a saved
add/migration license summary. This step is optional.

Options

When the license file has been selected (using the Browse button), it
appears in the License File field. The Install button is then used to install
that license file.

Install button

Table 7: License Request and Next Steps Dialog Box

DescriptionSetting

The first step in the License Request and Next Steps dialog box provides
the following options: copy the text in the text box to your clipboard or
click the link to save the license request file to your computer.

Copy the selected text

The second step instructs you to register your licenses by clicking the
link provided.

Register your Licenses

The third step advises you to return to Cisco Prime License Manager
and install your licenses once you have received them. License files are
generally obtained via email or downloaded from the Cisco portal.

Clicking the Install button returns you to the Licenses page.

Install your Licenses

Table 8: PAK Details Page

DescriptionSetting

Clicking the Adjust PAK Fulfillment link at the top of the PAK Details
page retrieves the latest PAK details, changes the table from read-only
to editable, and allows you to adjust the PAK fulfillment for Cisco Prime
License Manager.

Adjust PAK Fulfillment option
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DescriptionSetting

The PAK Contents table contains the following columns:

SKU Name

specifies the name of a license contained in the file

Type

specifies the license type (ex: Permanent, Time-limited)

Expiration

specifies the expiry date of time-limited licenses

Purchased

specifies the total number of that license type in the PAK

If you select the Adjust PAK Fulfillment option, the following additional
columns appear in the table:

• Before Fulfillment

◦Purchased

◦Fulfilled

◦Remaining

• Fulfill

• Remaining

• Actions

PAK Contents table

Table 9: View <File ID> Page

DescriptionSetting

The File Details section contains the following information:

• Fulfillment Date

• Description

• Associated Summary

• Method (File Install, e-Fulfillment, or Retrieve Fulfilled Licenses)

• Cisco.com Username

• PAK

• PAK Partial Fulfillment

Transaction Details
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DescriptionSetting

The Licenses Fulfilled section contains a table that lists license files
under the following categories:

• Type

• Product Type

• Total on System (the number of that particular license type)

• Expiration date

License Details

Table 10: Edit Transaction Details Dialog Box

DescriptionSetting

Clicking the Edit Transaction Details button in the View <File ID>
window opens the Edit Transaction Details dialog box, which contains
the following information:

• Fulfillment Date

• Description

• Associated Summary

• Method (File Install, e-Fulfillment, or Retrieve Fulfilled Licenses)

• Cisco.com Username

• PAK

• PAK Partial Fulfillment

The Description and Associated Summary fields can be edited.

Edit Transaction Details

Product Instances View Settings
The Product Instances page allows you to view product license information. From this page, you can add,
delete, or synchronize product instances.

DescriptionSetting

Product Instances

Specifies the name of the product instanceName

Specifies the hostname or IP address of the product instanceHostname/IP Address

Specifies the type of product instanceProduct Type
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DescriptionSetting

Specifies the product release of the product instanceVersion

Specifies the status of the product instance synchronization (for example,
“Success”, “Registration Conflict”, “Invalid Server Type”, “Insufficient
Licenses”)

Status

Specifies the date and time of the last successful synchronization.Last Successful
Synchronization

Clicking the Add button on the Product Instances page opens the Product
Add dialog box. From this dialog box, you can enter the following
information:

• Name

• Description (optional)

• Product Type

• Hostname/IP Address

• Username

• Password

Once you have added your new product instance, be sure to click
the Synchronize Now button to extract current licensing
information from the product. If you do not synchronize, current
product instance information may not appear in Cisco Prime
License Manager.

Note

Add button

From the Product Add dialog box, you can click the Test Connection button
to test the connection to the product instance prior to adding it.

If the connection cannot be established, either through the connection test
or by clicking OK to add a product instance, you may receive one of the
following error messages:

• Instance Unreachable

• Login Failed

• Certificate Mismatch

• Registration Conflict

• Invalid Server Type

• Product Type Mismatch

• Duplicate Product Instance

You may also skip the Test Connection button and click OK on
the Add Product Instance dialog box.

Note

Test Connection button
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DescriptionSetting

You can delete a product instance by clicking the Delete link under the
Action column for the product instance.

Delete button

You can open the administration GUI for a particular product instance by
selecting the check box next to the product instance and clicking Launch
Admin GUI.

Launch Admin GUI button

Synchronizes Cisco Prime License Manager with the product instances to
obtain the most up-to-date licensing information for all license types in the
system

Synchronize Now button

Product Instance details page

Clicking on a product instance in the Product Instance table opens the following details
page

Note

The General tab is divided into two sections:

• Product

• Administrator Account

The Product section contains the following information:

• Name

• Description

• Hostname/IP Address

• Product Type

• Product Version

The Administrator Account section contains the following fields:

• Username

• Password

Clicking the Save button saves your changes.

Prior to clicking the Save button, you have the option of clicking
the Test Connection button to ensure that the connection is
established.

Note

General tab

The License Usage tab contains a graphical representation of the license
requests and a table illustrating the number of licenses requested by license
type.

License Usage tab
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Administration View Settings
In a standalone deployment, the Administration view allows you to configure the following Cisco Prime
License Manager settings:

• Administrator Accounts

• Backup/Restore

• Install/Upgrade

• License Definitions

• Diagnostic Logs

• Restart

A coresident deployment has similar settings but backup/restore and install/upgrade options must be configured
using Cisco Unified Communications Manager:

• Administrator Accounts

• OS Administration

• Disaster Recovery

• License Definitions

• Diagnostic Logs

• Restart

For information about OS Administration or Disaster Recovery, see the Cisco Unified Communications
Operating System Administration Guide or Disaster Recovery System Administration Guide for Cisco
Unified Communications Manager.

Note

DescriptionSetting

Administrator Accounts

Selecting the Add Administrator button in the Administrator Accounts
window opens the Add Administrator Account window.

From this window, you can add an administrator account. You are
prompted for the following information:

• Name/Description

• Username

• Password

• Re-enter Password

Add Administrator button
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DescriptionSetting

Selecting the Change Password link in the Administrators table opens
the Change Password page. From this page you can change the password
of an existing administrator account. You are prompted for the following
information:

• New Password

• Re-enter New Password

Change Password

Backup/Restore

The Backup Server section contains the following fields:

• IP Address/Hostname

• Username

• Password

• Directory

The IP Address/Hostname specifies the IP Address/Hostname of the
server to be backed up or restored. Enter your username and passport
to connect to the server. The Directory field specifies the location of
the backed up server (for example: /ws/user1-rcd/backup2)

The Backup/Restore page also indicates when the last backup was
performed.

Backup Server

The Run Backup button initiates a backup of the server specified in the
IP Address/Hostname field.

Run Backup button

The Run Restore button initiates a restore of the server specified in the
Directory field.

Run Restore button

The Test Connection button allows you test the connection to the
product instance prior to performing a backup or restore.

Test Connection

Install/Upgrade

Use this page to upgrade your Cisco Prime License Manager software
or to add options such as language packs to your system.

Install/Upgrade page

Lists the active and inactive system software versionsSystem Software
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DescriptionSetting

Clicking on the Install/Upgrade Software button opens the
Install/Upgrade Software wizard. This is a two-step wizard:

1 Specify File Location

2 Select File

The Specify File Location page provides two options:

• Install/Upgrade from Network

• Install/Upgrade from DVD/CD drive on Cisco Prime License
Manager server

The Install/Upgrade from Network option requires the following
information:

• IP Address/Hostname

• Username

• Password

• Directory

• Transfer Protocol

The IP Address/Hostname field specifies the location of the file to be
installed or used for the upgrade . Enter your username and password
to connect to the server. The Directory field specifies the location where
the install or upgrade will be saved.

The Transfer Protocol specifies the method: SFTP or FTP

All valid upgrades are listed in the table. Select the appropriate (valid)
upgrade file from the list and click the Start Installation/Upgrade button
to begin the upgrade.

Install/Upgrade Software wizard

License Definitions

The License Definitions page contains information about the license
typesmanaged byCisco Prime LicenseManager. The LicenseDefinition
file should be updated prior to upgrading any of your product instances
to a new version or before adding a product instance of a new type.

License Definitions

Clicking Check for Latest Version opens the Cisco Prime License
Manager Dashboard, which provides an overview of the license types
currently in use.

Check for Latest Version

Clicking View Release Notes opens the License Definitions Release
Notes page, which lists:

• Changes Since Previous Version

• Supported Products

View Release Notes
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DescriptionSetting

Clicking the Install New License Definition File button opens the Install
License Definitions window. Click the Browse button to locate the
License Definitions File and then click Fulfill to install the file.

Install New License Definition File
button

Diagnostic Logs

The Log Settings tab lists the diagnostics categories and log levels. The
diagnostic categories include:

• Cisco Prime License Manager core services

• Communication with product instances

The Log Level drop-down list for each diagnostic category can be set
to one of the following:

• Error

•Warning

• Info

• Debug

Once the log level has been set for each diagnostic category, you can
save your changes by clicking the Save button. You may also opt to
reset your log settings by clicking the Reset button.

Log Settings tab

The Download Logs tab allows you to generate a log file, using the
date and time range of your choice to include in the log file. The default
range is from 12 AM of the current day until the current time. You can
then generate the file by clicking the Generate Log File button. The log
file is generated and downloaded to your computer.

Download Logs tab

Restart

Pressing the Restart button below restarts all Cisco Prime License
Manager services. This generally takes less than a minute and you will
automatically be taken to the login screen when the restart is complete.

Restart
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C H A P T E R  6
Troubleshooting

The following are recommended troubleshooting steps to address common issues that may occur when using
Cisco Prime License Manager:

• Unknown Username and Password, page 75

• Configuration Changes Are Not Appearing, page 76

• The Cause of The Error Is Unknown, page 76

• Product Instance was not Added, page 76

• Product Instance Was Modified, but Changes Are Not Reflected in License Usage Data, page 77

• Product Instance Was Deleted, but Is Still Showing Up in License Usage Data, page 77

• Product Instance Was Added and Is Not Showing Up in License Usage Data, page 77

• License Usage Data in Product Admin GUI Does Not Match Product Instances View, page 78

• Overage Alerts Are Not Appearing When License Manager Goes Into Overage, page 78

• License Manager Does Not Indicate a Product Overage, page 78

• Licenses Are Missing Following Restoration of License Manager on a Different Server, page 79

• Cannot Bring System Into Compliance Using the Upgrade Licenses Wizard, page 79

Unknown Username and Password
Description

I do not know the username and password of the system when it was originally installed, so I cannot log into
Cisco Prime License Manager.

Resolution

Log into the platform CLI with the OS administration credentials and use the license management list users
command to view the username to use for signing into the Cisco Prime License Manager application. If you
are not sure what the password is for this username, you can use the license management change user password
command to change this password.
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Configuration Changes Are Not Appearing
Description

I made a configuration change in my products, but I am not seeing a change in the requested licenses reflected
in Cisco Prime License Manager.

Resolution

Cisco Prime License Manager synchronizes with products every 24 hours. If you wish to see the latest
configuration changes, choose Product Instances and click Synchronize Now.

The Cause of The Error Is Unknown
Description

I received the following error message “The cause of the error is unknown”.

Resolution

Check the Cisco Prime License Manager diagnostic log for details. To access diagnostic logs, see Accessing
Diagnostic Logs, on page 50.

If the cause of the error is not easily identifiable from these details, please open a Service Request using the
TAC Service Request Tool, https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case, or send an email to
licensing@cisco.com. Please have your valid Cisco.com user ID and password available. As an alternative,
you may also call our main Technical Assistance Center at 800-553-2447.

Product Instance was not Added
Description

I tried to add a product instance for Cisco Unified Communications Manager but received a 401 error.

Resolution

Check the status of the account by executing the following CLI command: show accountlocking. You can
only add a product instance if the account is unlocked. Disable the lock on the account using the following
command: set accountlocking disable.
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Product Instance Was Modified, but Changes Are Not Reflected
in License Usage Data

Description

I modified the configuration of a product instance, but I do not see it reflected in the license usage data reported
on the Dashboard and License > Usage.

Resolution

When a product instance is added to the Cisco Prime License Manager, usage data is not available until the
Cisco Prime License Manager synchronizes with the product instance. Synchronization happens once every
24 hours, or can be manually requested from Product Instances using the Synchronize Now button.

Product Instance Was Deleted, but Is Still Showing Up in
License Usage Data

Description

I deleted a product instance, but I do not see it reflected in the license usage data reported on the Dashboard
and Licenses > Usage.

Resolution

When a product instance is deleted from Cisco Prime License Manager, usage data is not available until the
Cisco Prime License Manager synchronizes with the product instance. Synchronization happens once every
24 hours, or can be manually requested fromMonitoring > License Usage using the Synchronize Now button.

Product Instance Was Added and Is Not Showing Up in License
Usage Data

Description

I added a product instance, but I do not see it reflected in the license usage data in Monitoring > Dashboard
and Monitoring > License Usage.

Resolution

When a product instance is added to the Cisco Prime License Manager, usage data is not available until the
Cisco Prime License Manager synchronizes with the product instance. Synchronization happens once every
24 hours, or can be manually requested fromMonitoring > License Usage using the Synchronize Now button.
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License Usage Data in Product Admin GUI Does Not Match
Product Instances View

Description

The license usage data in the administration GUI for that product (for example, when I select Product Instances
> Launch Admin GUI) does not match the license usage reported at Cisco Prime License Manager in Product
Instances (select Product Instance Name).

Resolution

Changes in the configuration of a product instance are not seen in the Cisco Prime License Manager until the
next synchronization following the configuration change. Synchronization happens once every 24 hours, or
can be manually requested from Product Instance using the Synchronize Now button.

Overage Alerts Are Not Appearing When License Manager Goes
Into Overage

Description

I am not receiving any alerts when my Cisco Prime License Manager goes into overage.

Resolution

Overage alerts are generated by the product instances, not by Cisco Prime License Manager. Ensure that the
product supports overage alerting. If a product supports overage alerting, it must be configured in the GUI
for that product. For example, the administration interface in Unified CM allows you to specify which conditions
are alerted and in what manner. Therefore, if you are not seeing overage alerts for Unified CM, you should
verify that overage alerts are configured in Unified CM. If not, the alerts will be visible in the administration
interface, but you will not receive those alerts via the mechanism you have selected (for example, email,
SNMP, syslog).

License Manager Does Not Indicate a Product Overage
Description

My product says it is in overage, but my Cisco Prime License Manager does not show overage.

Resolution

If a product instance is unable to synchronize with its Cisco Prime License Manager, it goes into overage
because it is unable to confirm that there are licenses available. Please check the last synchronization date for
the product instance under Inventory > Product Instances. If synchronization is not occurring, verify that the
credentials in the Cisco Prime LicenseManager for the product instance are accurate and that there is network
connectivity between your Cisco Prime License Manager and the product instance.
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Licenses Are Missing Following Restoration of License Manager
on a Different Server

Description

I have restored my Cisco Prime License Manager on a different server and I do not have any licenses.

Resolution

When you move your Cisco Prime License Manager to a different virtual server, your licenses need to be
rehosted to the new server and reinstalled. Please open a Service Request using the TAC Service Request
Tool, https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case, or send an email to licensing@cisco.com
for next steps. Please have your valid Cisco.com user Id and password available. As an alternative, you may
also call our main Technical Assistance Center at 800-553-2447.

Cannot Bring System Into Compliance Using the Upgrade
Licenses Wizard

Description

In the Licenses > Planning > Create an Add Licenses Plan wizard, I am unable to bring the system into
compliance.

Resolution

If, across all the product instances managed by your Cisco Prime LicenseManager, you are using more licenses
than are already installed combined with those available from the product instances you are upgrading, you
will not have sufficient licenses to upgrade to bring your Cisco Prime License Manager into compliance. You
will need to purchase additional licenses to cover your needs, or reduce the number of licenses required by
your product instances by changing their configuration.

From the License Counts screen of the Create an Add Licenses Plan wizard, click the Run Compliance
Check button to determine your license count needs. If your receive a message stating "Compliance Check
Passed", you have a sufficient number of licenses and can click Next to move to the next screen in the
wizard. For more information, see License Planning, on page 42

Note
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A P P E N D I X  A
Cisco Prime License Manager CLI Commands

• Introduction, page 81

• license file, page 81

• license management change user, page 82

• license management list users, page 82

• license management product re-register all, page 83

• license management reset, page 83

• license management security update, page 84

• license management service, page 84

• license management show system, page 84

Introduction
The commands in this section are specific to Cisco Prime LicenseManager. For platform-specific commands,
see Command Line Interface Guide for Cisco Unified Communications Solutions.

license file
This command asks to select a license file from a list.

license file {diagnose| get}

Syntax Description DescriptionParameters

Prints diagnostic information of the selected file.diagnose

Creates a TAR file of the license file(s) on the system and transfers the TAR
file to a remote area.

get
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Command Modes Administrator (admin:)

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager

license management change user
This command takes parameters interactively and changes the username or password of the administrator.

license management change user {name| password}

Syntax Description DescriptionParameters

Specifies the administrator username.name

Specifies the administrator password.

The password must be at least six characters long, and can contain any
combination of alphanumeric characters or the following special characters:
underscore (_), exclamation mark (!), at sign (@), pound sign (#), dollar
sign ($), percentage sign (%), caret (^), and ampersand (&).

Note

password

Command Modes Administrator (admin:)

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager

license management list users
This command lists the administrative users.

license management list users

Command Modes Administrator (admin:)
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Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager

license management product re-register all
This command forces re-registration of all product instances associated with this Enterprise License
Manager/Cisco Prime License Manager server. This command may take some time for re-registration and
synchronization with all product instances to complete.

license management product re-register all

Command Modes Administrator (admin:)

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager

license management reset
This command resets the identity, store data, and essentially removes all the installed licenses. It also restarts
the Cisco Prime License Manager server process to make the changes effective.

license management reset {identity| registration}

Syntax Description DescriptionParameters

Resets the identityidentity

Resets the registrationregistration

Command Modes Administrator (admin:)

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager
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license management security update
This command downloads Cisco Prime License Manager security update from the specified remote server
location and installs the contents of the specified security update file.

license management security update

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager

license management service
This command activates or deactivates a given service on the Cisco Prime License Manager server.

license management service {activate| deactivate}

Syntax Description DescriptionParameters

Activates a given service on the Cisco Prime License Manager server.activate

Deactivates a given service on the Cisco Prime License Manager server.deactivate

Command Modes Administrator (admin:)

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager

license management show system
This command lists the administrative users.

license management show system

Command Modes Administrator (admin:)
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Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Enterprise License Manager, Cisco Prime License Manager
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